Table of Contents

M5 Workstation User’s Guide

Chapter 1

Getting Started on the M5 Workstation ...................1-1

Introduction...................................................................................................... 1-1

Key Concepts................................................................................................... 1-2

Screen Manager............................................................................................................. 1-2

M-Password ................................................................................................................... 1-2

Related Information........................................................................................................ 1-3

Detailed Procedures........................................................................................ 1-4

Launching M5 Workstation............................................................................................. 1-4

Logging On to an M5 Workstation.................................................................................. 1-4

Logging Off an M5 Workstation...................................................................................... 1-5

Chapter 2

Using the Network Map ......................................................2-1

Introduction...................................................................................................... 2-1

Key Concepts................................................................................................... 2-2

Metasys Network Map.................................................................................................... 2-2

M5 Workstation Shortcut Menu Items ............................................................................ 2-3

M5 Multinetwork Feature.............................................................................................. 2-3

Network Map Toolbar Buttons........................................................................................ 2-5

Network Map Menu Items .............................................................................................. 2-6

Detailed Procedures........................................................................................ 2-7

Launching Functions from the Toolbar........................................................................... 2-7

Accessing Common Operations..................................................................................... 2-7

© June 18, 2004 Johnson Controls, Inc.  www.johnsoncontrols.com
Chapter 3  Binding Components .................................................................3-1

Introduction ............................................................................................... 3-1

Key Concepts ..............................................................................................3-2
Component Binding .....................................................................................3-2
Fast Bind ......................................................................................................3-2
M-Bind.mdb ...............................................................................................3-2
Component Configurator ..........................................................................3-3
M-Bind.ini .................................................................................................3-4

Procedure Overview ..................................................................................3-6

Detailed Procedures ....................................................................................3-7
Binding a Component File ..........................................................................3-7
Performing a Fast Bind .............................................................................3-9
Launching a Component ...........................................................................3-10
Removing a Component File Binding ......................................................3-11
Removing Multiple Component File Bindings .......................................3-11
Removing Metasys (Micrografx) Graphics Bindings .............................3-12
Modifying an Existing Component ..........................................................3-13
Adding a New Component ......................................................................3-14
Deleting an Existing Component ............................................................3-14

Chapter 4  Using Screen Manager ...............................................................4-1

Introduction ...............................................................................................4-1

Key Concepts ..............................................................................................4-3
M-Password ...............................................................................................4-3
Metasys Operator Workstation (OWS) Integration ..................................4-4
Templates ..................................................................................................4-5
Application Files .......................................................................................4-5
Layouts .......................................................................................................4-5
Panel ...........................................................................................................4-6
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Manager Command Bar</td>
<td>4-6</td>
</tr>
<tr>
<td>Template/Layout File Naming Conventions</td>
<td>4-8</td>
</tr>
<tr>
<td>Windows Taskbar</td>
<td>4-8</td>
</tr>
<tr>
<td>Multiple Monitor Support</td>
<td>4-8</td>
</tr>
<tr>
<td>Slide Show</td>
<td>4-8</td>
</tr>
<tr>
<td>Default Layout</td>
<td>4-9</td>
</tr>
<tr>
<td>Controlling Screen Manager via M-Graphics Pick Actions</td>
<td>4-9</td>
</tr>
<tr>
<td>OPC Universal Tag Browser</td>
<td>4-10</td>
</tr>
<tr>
<td>OWSExec</td>
<td>4-10</td>
</tr>
<tr>
<td>Tag</td>
<td>4-10</td>
</tr>
<tr>
<td><strong>Detailed Procedures</strong></td>
<td>4-11</td>
</tr>
<tr>
<td>Launching Screen Manager</td>
<td>4-11</td>
</tr>
<tr>
<td>Logging In to the M5 Workstation via M-Password</td>
<td>4-11</td>
</tr>
<tr>
<td>Logging Out of M5 Workstation via M-Password</td>
<td>4-12</td>
</tr>
<tr>
<td>Managing Alarm and Event Messages</td>
<td>4-12</td>
</tr>
<tr>
<td>Configuring the Alarm Indicator</td>
<td>4-13</td>
</tr>
<tr>
<td>Launching Layouts or Selecting Templates</td>
<td>4-13</td>
</tr>
<tr>
<td>Creating a Custom Template</td>
<td>4-14</td>
</tr>
<tr>
<td>Renumbering Panels in a New Template</td>
<td>4-15</td>
</tr>
<tr>
<td>Populating a Layout</td>
<td>4-15</td>
</tr>
<tr>
<td>Modifying Panel Properties</td>
<td>4-16</td>
</tr>
<tr>
<td>Saving a Panel Layout</td>
<td>4-19</td>
</tr>
<tr>
<td>Realigning a Panel Layout</td>
<td>4-19</td>
</tr>
<tr>
<td>Launching Layouts from the Recent List</td>
<td>4-20</td>
</tr>
<tr>
<td>Registering New Applications</td>
<td>4-20</td>
</tr>
<tr>
<td>Deleting Existing Applications</td>
<td>4-21</td>
</tr>
<tr>
<td>Modifying Application Launch Properties</td>
<td>4-21</td>
</tr>
<tr>
<td>Modifying Screen Manager Properties</td>
<td>4-23</td>
</tr>
<tr>
<td>Setting Up the Alarm Icon Path in Screen Manager</td>
<td>4-25</td>
</tr>
<tr>
<td>Docking the Screen Manager Command Bar</td>
<td>4-26</td>
</tr>
<tr>
<td>Floating the Screen Manager Command Bar</td>
<td>4-27</td>
</tr>
<tr>
<td>Minimizing the Screen Manager Command Bar</td>
<td>4-27</td>
</tr>
<tr>
<td>Activating Metasys OWS (with Autologin)</td>
<td>4-28</td>
</tr>
<tr>
<td>Activating Metasys OWS (without Autologin)</td>
<td>4-28</td>
</tr>
</tbody>
</table>
Controlling Screen Manager Panels via M-Graphics Pick Actions ........................................... 4-28
Exiting M5 Workstation ........................................................................................................... 4-29

**Troubleshooting** ................................................................................................................. 4-30
Logon Attempt Fails – Invalid User ......................................................................................... 4-30
Logon Attempt Fails – Invalid Password ................................................................................ 4-30
Logon Attempt Fails – User is Disabled .................................................................................. 4-30
Closing the M5 Workstation Software Does Not Close All Applications .............................. 4-30
Unable to Float or Dock Screen Manager Command Bar ....................................................... 4-30
Buttons Unavailable on Screen Manager Command Bar ....................................................... 4-31
Not Authorized Message on Startup ...................................................................................... 4-31
Layout Errors ............................................................................................................................ 4-31

Chapter 5  **M-Graphics** ........................................................................................................... 5-1

**Introduction** .......................................................................................................................... 5-1

**Key Concepts** ....................................................................................................................... 5-2
M-Graphics Features ................................................................................................................. 5-2
Data Source Connections ......................................................................................................... 5-2
OPC Universal Tag Browser .................................................................................................... 5-3
OWSExec ...................................................................................................................................... 5-3
Property Inspector .................................................................................................................... 5-3
Related Information .................................................................................................................. 5-3

**Detailed Procedures** ............................................................................................................ 5-4
Launching a Metasys Window or Dialog Box from M-Graphics ................................................ 5-4

Chapter 6  **N1 Trend Collector** ............................................................................................... 6-1

**Key Concepts** ....................................................................................................................... 6-2
N1 Trend Collector ..................................................................................................................... 6-2
N1 Trend Collector Specifications ............................................................................................. 6-3
N1 Trend Collector Configuration Options ................................................................................ 6-3
Data Security ............................................................................................................................... 6-9
M-Historian Database Component ............................................................................................ 6-9
Metasys Remote Server (MRS) ................................................................................................ 6-9
USER_APP File Destination ...................................................................................................... 6-11
## Table of Contents

### Metasys Point History Reports
- Fast Scan: 6-11
- Point Status: 6-13
- Metasys Trend Reports: 6-13

### N1 Trend Collector Application Window
- System Tray Icon: 6-16
- Historian Node Monitoring: 6-16
- ODBC: 6-20

### Related Information
- Detailed Procedures: 6-21
- Configuring a Trend Collection: 6-21
- Enabling Trend Collection for Metasys N1 Objects: 6-25
- Displaying the N1 Trend Collector Application Window: 6-25
- Defining the USER_APP File Destination: 6-25
- Defining Analog Data (AD) Points and Binary Data (BD) Points for Historian Node Monitoring: 6-26
- Enabling Offline Node Detection: 6-26
- Disabling Offline Node Detection: 6-27

### Troubleshooting
- Troubleshooting the Historian Node Monitor: 6-28
- Maintaining the Microsoft Access File Size: 6-28
- Trend Sample Bandwidth in Fast Scan Mode: 6-29
- Fast Scan Configuration: 6-31
- Accessing Database Files via DSN: 6-31
- Verifying the Operation of the Metasys Remote Server: 6-32
- M-Historian Error Codes: 6-32
- Special Error Codes: 6-34
- Data Collection Troubleshooting: 6-34
- Troubleshooting the Windows Registry Entries: 6-36

### Chapter 7 M-Trend

#### Introduction
- 7-1

#### Key Concepts
- 7-2

#### M-Trend Features
- 7-2
M-Trend Data Connection Overview ................................................................. 7-2
Related Information .......................................................................................... 7-2

Appendix A  M-Bind.mdb ........................................................................... A-1

Appendix B  ProjInfo.ini .............................................................................. B-1

Introduction ........................................................................................................ B-1
Key Concepts ........................................................................................................ B-2
ProjInfo.ini .......................................................................................................... B-2
Default Data Files ............................................................................................... B-3
Ignore External Filters ........................................................................................ B-3
History .................................................................................................................. B-4
Gwx32 .................................................................................................................. B-4
Awx32 .................................................................................................................. B-4
Application List ................................................................................................... B-4
Command Bar ....................................................................................................... B-5

Appendix C  Metasys OWS AutoLogin ...................................................... C-1

Introduction ........................................................................................................ C-1
Key Concepts ........................................................................................................ C-2
Metasys OWS AutoLogin .................................................................................... C-2
Auto Logon to M-Password from Windows NT .................................................. C-2
Detailed Procedures ............................................................................................ C-3
Manual Setup ....................................................................................................... C-3
Changing Passwords ............................................................................................ C-3
Troubleshooting ................................................................................................. C-4

Appendix D  Screen Manager Slide Show .................................................. D-1

Introduction ........................................................................................................ D-1
Key Concepts ........................................................................................................ D-2
SlideShow.txt ...................................................................................................... D-2
Default Location ................................................................................................. D-2
Slide Show Specifications ................................................................................... D-3
Appendix E  Managing DSNs with the ODBC Data Source

Administrator ........................................................................................................ E-1

Introduction ........................................................................................................ E-1

Detailed Procedures ........................................................................................... E-2

Appendix F  Configuring the Historian Node Monitor................................. F-1

Defining the AD and BD Points ........................................................................ F-2
Configuring the JC Basic Process ..................................................................... F-2
Configuring the N1 Trend Collector ................................................................. F-3
Chapter 1

Getting Started on the M5 Workstation

Introduction


This chapter describes how to:

• launch M5 Workstation
• log on to an M5 Workstation
• log off an M5 Workstation
Key Concepts

Screen Manager

Screen Manager is the principal method of interfacing with the M5 Workstation. Typically, you launch the M5 Workstation application (from the Windows Start menu), then click the Screen Manager Logon button to log on to the M5 Workstation. Screen Manager provides the user with the ability to manage screen space by providing defined screen layouts. For more information, refer to the Using Screen Manager (LIT-1153855) chapter in this guide.

M-Password

To log on to the M5 Workstation, users and passwords must be defined in M-Password. M5 Workstation users must use M-Password to:

- add a new user
- set user password
- add a new group (of users)
- assign privileges to a user
- assign privileges to all users
- assign privileges to a group
- assign a user to a group
- remove a user from a group
- delete a user
- delete a group

For complete information on M-Password functionality, refer to M-Password Technical Bulletin (LIT-1153150) and M-Password Application Actions Technical Bulletin (LIT-1153175).
## Related Information

### Table 1-1: Related Information

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-Authorize</td>
<td>Using M-Authorize Technical Bulletin (LIT-6424400)</td>
</tr>
<tr>
<td>M-Explorer</td>
<td>M-Explorer User’s Guide</td>
</tr>
<tr>
<td>M-Command</td>
<td>M-Explorer User’s Guide</td>
</tr>
<tr>
<td>M-Inspector</td>
<td>M-Explorer User’s Guide</td>
</tr>
<tr>
<td>M-Schedule</td>
<td>M-Schedule/M-Calendar User’s Guide</td>
</tr>
<tr>
<td>M-Calendar</td>
<td>M-Schedule/M-Calendar User’s Guide</td>
</tr>
<tr>
<td>M-Alarm</td>
<td>M-Alarm User’s Guide</td>
</tr>
<tr>
<td>M-Password</td>
<td>M-Password Technical Bulletin</td>
</tr>
<tr>
<td></td>
<td>M-Password Application Actions Technical Bulletin (LIT-1153175)</td>
</tr>
<tr>
<td>BACnet OPC Server</td>
<td>Object Dictionary</td>
</tr>
<tr>
<td>N1 OPC Alarm and Event Server</td>
<td>M-Alarm User’s Guide</td>
</tr>
<tr>
<td>M-Collector</td>
<td>Using M-Collector Technical Bulletin (LIT-1153700)</td>
</tr>
<tr>
<td>N30 Supervisory Controller</td>
<td>N30 Supervisory Controller Technical Manual</td>
</tr>
<tr>
<td></td>
<td>N30 Supervisory Controller User’s Manual</td>
</tr>
<tr>
<td></td>
<td>N30 Supervisory Controller System Communications Manual</td>
</tr>
<tr>
<td>Cardkey PEGASYS 2000</td>
<td>PEGASYS 2000 NT (PUBL-3089)</td>
</tr>
</tbody>
</table>
Detailed Procedures

Launching M5 Workstation

To launch M5 Workstation:

From the Windows Start menu, choose Programs > Johnson Controls > M5 Workstation. The Screen Manager command bar (Figure 1-1) appears.

Logging On to an M5 Workstation

To log on to an M5 Workstation:

1. On the Screen Manager command bar, click Logon. The Security Login dialog box (Figure 1-2) appears.

   ![Figure 1-2: M-Password Login Dialog Box](image)

2. Enter your user name and password.
3. Click OK.

   Note: The Keypad button displays the Keyboard dialog box. You can click on the keyboard letters instead of typing the password. The Back button deletes the last character typed. The Clear button erases the entire field.
Logging Off an M5 Workstation

**IMPORTANT:** When an M-Series Workstation communicates to N30 devices via modem, the modem connection does not automatically disconnect when the user is logged out of M-Password. Be sure to manually disconnect the modem connection using M-Explorer before logging out of M-Password.

To log out of M5 Workstation via M-Password:

1. On the Screen Manager Task Bar, click Logon. The Johnson Controls M-Password window (Figure 1-3) appears.

2. On the User menu, click Logout.

3. To exit M-Password, on the User menu, click Exit.

**Figure 1-3: Security Login Dialog Box**

2. On the User menu, click Logout.

3. To exit M-Password, on the User menu, click Exit.
Chapter 2

Using the Network Map

Introduction

The Network Map displays the structure of the entire Metasys N1 network in tree diagram form. This chapter describes enhancements to the Network Map window and menu and how to:

- launch functions from the toolbar
- access common operations
- create a new component file
- display an existing component file
- switch between active networks

Note: The Network Map functionality detailed in this chapter is provided by the Metasys Operator Workstation Person-Machine Interface software, and is only accessible if M5 Workstation software is installed together with the Metasys OWS PMI software on the same PC platform.
**Key Concepts**

**Metasys Network Map**

The Network Map allows quick access to facility information. It displays all the groups, systems, N1 devices, and files in the currently active network in diagram form.

Figure 2-1 is an example of the M5 Workstation Network Map.

![Network Map Example](image-url)

**Figure 2-1: M5 Workstation Network Map**
The M5 Network Map features a toolbar and shortcut menus. Access to features such as M-Graphics and M-Trend is provided through menus and shortcut menus. Figure 2-1 is an example of the Network Map.

**M5 Workstation Shortcut Menu Items**

To display a shortcut menu that allows access to the following features, right-click a Network Map item.

**Table 2-1: M5 Workstation Shortcut Items**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Components</td>
<td>M-Graphics</td>
<td>Launches M-Graphics with bound component file. If component file isn’t bound, displays a prompt to display Component Binding dialog box.</td>
</tr>
<tr>
<td>Screen Manager</td>
<td></td>
<td>Launches a bound component file within Screen Manager. If there is no component binding, the Network Map prompts to display the Component Binding dialog box.</td>
</tr>
<tr>
<td>M-Trend</td>
<td></td>
<td>Launches M-Trend with bound component file. If component file isn’t bound, displays a prompt to display Component Binding dialog box.</td>
</tr>
<tr>
<td>Go To</td>
<td></td>
<td>Refer to the Getting Started (LIT-120165) section of the Operator Workstation User’s Manual for more information.</td>
</tr>
<tr>
<td>Component Binding</td>
<td></td>
<td>Displays Component Binding dialog box.</td>
</tr>
</tbody>
</table>

**M5 Multinetwork Feature**

The M5 Workstation Multinetwork feature allows a single M5 Workstation to simultaneously monitor the operation of up to five logically independent N1 networks configured on one physical Ethernet network. (An ARCNET® network connected via an Ethernet router also qualifies.) This provides a single seat user interface for a Metasys system that allows you to define more than 1500 system names. This feature also supports the extension of Metasys systems beyond the 1500 system name limit of one N1 network without re-engineering system names. Additional M5 Workstations on the network can be configured to access any or all of the independent N1 networks.

Except as noted, the following M5 Workstation Multinetwork functions and feature interactions are the same as they would be on a Metasys Operator Workstation (OWS) connected simultaneously to an N1 and one or more direct-connect/dial-up networks.
Refer to the *N1 Ethernet/IP Network Technical Bulletin (LIT-6360175)* for additional information about configuring multiple N1 networks.

**Note:** This feature is supported on a Windows NT® or Windows® 2000 platform running M5 Workstation Release 5.0 or later and Metasys Release 12.00 or later software.

**Alarm Annunciation**

Alarms from all connected networks are annunciated via the Critical Alarm dialog box, regardless of which N1 network the operator may be logged into.

We recommend using M-Alarm for primary alarm annunciation. In this case, disable the Critical Alarm dialog box reporting.

**Password**

If an operator uses the same password for several networks, logging on to any of the networks gives access to all networks. It is not necessary to re-enter a password when switching between networks. The Logoff timer for an unattended workstation is defined on a per network basis.

**Note:** M-Password is required for initial login to the M5 Workstation software and M-Series applications. The Metasys password is still required for access to Metasys PMI applications.

**Network Map**

The easiest method to switch between N1 networks is to click the Change Network icon on the toolbar. Another option is to select View > Change Network from the currently displayed Network Map. Selecting Setup > Network from the currently displayed network map displays the Network Summary. This summary includes NC Direct, NC Dial, and N1 Direct networks. Select the desired network and choose Action > Activate Network to display the newly selected Network Map. You can display only one network on the Network Map at any time.

When changing networks, several seconds may elapse before the current map is replaced. During this time, the change is taking place even though the cursor does not appear as an hourglass. This delay may be especially noticeable during the first few minutes after starting the Metasys Network.

**Report Access Groups**

Each individual Metasys N1 Ethernet Network can define its own set of Report Access Groups (Metasys Release 11.00 or later allows a maximum of 32 groups per network).
Software Features

Most software features access network data on a network-by-network basis. For example, summaries display records only for objects in the system whose network map is currently active (displayed). Among the exceptions are Metalink™, M-Graphics, M-Alarm, and M-Trend, which can access data simultaneously from any accessible network.

Configuration Options

The Multi-Network feature requires Metasys Release 12.00 or later and Windows NT or Windows 2000.

Note: The M5 Workstation Multi-Network feature supports direct-connect and dial-up networks, as well as N1 networks. No more than five networks can be active simultaneously. Definitions in the NET.DDL file can include five N1 networks only.

Network Map Toolbar Buttons

The Network Map toolbar provides a shortcut to selected functions. Click a toolbar button to activate the corresponding function.

Table 2-2: Network Map Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>Item Open</td>
</tr>
<tr>
<td>![Image]</td>
<td>Item Save</td>
</tr>
<tr>
<td>![Image]</td>
<td>Item Print</td>
</tr>
<tr>
<td>![Image]</td>
<td>View Show as Drawing (Toggles with View Show as Text)</td>
</tr>
<tr>
<td>![Image]</td>
<td>View Show as Text (Toggles with View Show as Graphics)</td>
</tr>
<tr>
<td>![Image]</td>
<td>Action Component Binding</td>
</tr>
<tr>
<td>![Image]</td>
<td>Set Up PC User Options</td>
</tr>
<tr>
<td>![Image]</td>
<td>Help Topics</td>
</tr>
<tr>
<td>![Image]</td>
<td>Change N1 Network</td>
</tr>
</tbody>
</table>
Network Map Menu Items

The menu items listed in Table 2-3 are functional modifications to the Network Map. Some items have been disabled, and appear grayed out. For additional information about menu items, refer to the Operator Workstation User’s Manual.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>New</td>
<td>Launches selected component.</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Displays Component Document Browse and Launch dialog box.</td>
</tr>
<tr>
<td>View</td>
<td>Display Screen Manager on Logon</td>
<td>Not available</td>
</tr>
<tr>
<td>Action</td>
<td>Component Binding</td>
<td>Displays Component Binding dialog box.</td>
</tr>
<tr>
<td>Components</td>
<td>M-Graphics (or other component)</td>
<td>Launches M-Graphics and displays bound component file. A message appears if no component binding exists.</td>
</tr>
<tr>
<td>Setup</td>
<td>Remove Metasys Graphics</td>
<td>Removes Metasys graphics bindings.</td>
</tr>
<tr>
<td></td>
<td>Component Binding Configurator</td>
<td>Displays the Component Configurator dialog box.</td>
</tr>
<tr>
<td>Exit</td>
<td>Change Users</td>
<td>Displays the Network Map – Logoff dialog box, then closes the Network Map.</td>
</tr>
<tr>
<td></td>
<td>Logoff</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td>Program Manager</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td>GPL</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td>Designer</td>
<td>Not available</td>
</tr>
<tr>
<td>Help</td>
<td>Feature Help &gt; M5</td>
<td>Displays M5 Workstation help files.</td>
</tr>
</tbody>
</table>
Detailed Procedures

Launching Functions from the Toolbar
To access a function from the toolbar, click on the icon.

Accessing Common Operations
To access common operations for a selected object:
1. Right-click on the object.
2. Select operation from the menu.

Creating a New Component File
To create a new component file:
1. On the Network Map, select Item > New, and select the desired component (M-Graphics, M-Trend, or Screen Manager).
2. Component is launched. Refer to Table 2-4 to find more information on creating and optimizing the chosen component.

Table 2-4: Specific Component Documentation

<table>
<thead>
<tr>
<th>Component</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Manager</td>
<td>Chapter 4, M5 Workstation User's Guide: Using Screen Manager (LIT-1153855)</td>
</tr>
</tbody>
</table>

Note: For component binding, refer to the Binding Components (LIT-1153840) chapter in this manual for more information.

Displaying an Existing Component File
To display an existing component file:
1. On the Network Map, select Item > Open, and select the desired component (M-Graphics, M-Trend, or Screen Manager).
2. The Document Browse and Launch dialog box appears. Select the desired component file.

Notes: Default files for M-Graphics are located in:
C: \Documents and Settings \All Users \Application Data \Johnson Controls \M-Data.

For component binding, refer to the Binding Components (LIT-1153840) chapter in this manual for more information.
Switching Between Active Networks

To switch between networks:

1. On the Network Map, select View > Change Network.
2. Select desired network to view its Network Map. Only networks that are accessible with operator’s logon password display.

Note: The Change Network button on the Network Map also can be used to switch between active networks.
Chapter 3

Binding Components

Introduction

Component binding provides a mechanism for extending the Metasys® system feature set by associating a Network Map item in the Metasys system with standalone component files. This chapter describes how to:

• bind a component file
• perform a fast bind
• launch a component
• remove a component file binding
• remove multiple component file bindings
• remove Metasys (Micrografx®) graphics bindings
• modify an existing component
• add a new component
• delete an existing component

Notes: Install Metasys OWS PMI software before installing the M5 Workstation software. The component containing the Network Map functionality then is installed automatically.

Component bindings from M5 Workstation Release 2.0 software are maintained when upgrading to M5 Workstation Release 5.0 software. While you may continue to use these bindings, modify existing bindings, and add new ones, we recommend that you use the M5 Workstation Release 5.0 Screen Manager interface to access the M-Series applications.
Key Concepts

Component Binding

Component binding associates Metasys system items from the Network Map (network, system, or group) with component files. The default component files include:

- Screen Manager (*.pwf)
- M-Graphics (*.gdf if M-Graphics is installed)
- M-Trend (*.htv if M-Trend is installed)

Additional components can be added using the Component Configurator.

Fast Bind

The Fast Bind feature binds multiple Network Map items to a single component document.

Fast Bind and M-Graphics provides a mechanism to associate multiple Metasys systems on the Network Map to the same M-Graphics picture file. This is useful for jobs that have multiple systems with the same object names. When the M-Graphics picture associated with a Network Map system is displayed, the M-Graphics bindings are dynamically resolved.

M-Graphics uses aliases to make this possible. Use an alias as a placeholder for the Network and System portion of the Tag. When a graphic containing an alias is displayed, the aliases are replaced with the appropriate Network and System name. Refer to the M-Graphics User’s Manual for information on M-Graphics aliasing.

M-Bind.mdb

Specific component binding information is stored in a Microsoft® Access database named M-Bind.mdb. Refer to Appendix A: M-Bind.mdb (LIT-1153890) for more information.
Component Configurator

The Component Configurator modifies, adds, or deletes components. The information is stored in the M-Bind.ini file. See *M-Bind.ini* later in this section for more information.

Note: We strongly recommend using the Component Configurator to add, modify, and delete components. Directly modifying the M-Bind.ini file is not recommended.

![Component Configurator Dialog Box](image)

**Figure 3-1: Component Configurator Dialog Box**
M-Bind.ini

The M-Bind.ini file is created during the M5 Workstation installation and stores key software component binding information. An example of this file is shown in Figure 3-2. The file has two parts, the master component section and individual component sections.

Note: We strongly recommend using the Component Configurator to add, modify, and delete components. Directly modifying the M-Bind.ini file is not recommended.

The components section identifies which M5 Components (for example, M-Graphics) are able to launch from the PMI Network Map. You may launch any of the components listed in the Components Section from the PMI Network Map.

The CompNames lists the M5 Components that are able to launch from the PMI Network Map. If you remove one of the component names, the component is no longer able to launch from the PMI Network Map. The Database lists the location and name of the database file used by the M-Bind application. You must update this file if you rename or move the database location. HelpFile lists the directory location of the M5 Help files. You must update this file if you change the location of the M5 Help files. The key fields are described in Table 3-1.

Table 3-1: M-Bind.ini Component Section Key Fields

<table>
<thead>
<tr>
<th>Key*</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CompNames</td>
<td>A comma-delimited list of names.</td>
</tr>
<tr>
<td>Database</td>
<td>The directory path of the M-Bind.mdb database file that stores the fully qualified Network Map object name and component document name associations.</td>
</tr>
<tr>
<td>HelpFile</td>
<td>The directory and path of the M5 Help files.</td>
</tr>
</tbody>
</table>

* All Key components are required.

Figure 3-2 is an example of the M-Bind.ini file. This example contains a section for each installed component. This section lists key parameters as described in Table 3-2. The component names must match the component names listed in the CompNames field.
Table 3-2: M-Bind.ini Individual Component Section Fields

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Menu name and Alt key designation for the Network Map</td>
</tr>
<tr>
<td>Type</td>
<td>Document type (extension)</td>
</tr>
<tr>
<td>Typename</td>
<td>File type description to be used with Component Document</td>
</tr>
<tr>
<td>Exepath</td>
<td>Full directory path and executable name</td>
</tr>
<tr>
<td>Exeparam</td>
<td>Additional application command line arguments for Runtime operation</td>
</tr>
<tr>
<td>Docpath</td>
<td>Default directory path for component files</td>
</tr>
<tr>
<td>Alias</td>
<td>Network and/or System Aliases used in M-Graphics component file; for example, NET or SYS</td>
</tr>
<tr>
<td>Delim</td>
<td>Delimiter for fully qualified product name, used for parsing in the case of aliasing, for example “\”</td>
</tr>
</tbody>
</table>

```
[Components]
CompNames =M-Graphics,M-Trend,M-ScrMgr
Database = C:\Documents and Settings\All Users\Application Data\Johnson Controls\M-Data\M5 Component\Active Database\m-bind.mdb
Helpfile = C:\Program Files\Johnson Controls\M5 Master

[M-Graphics]
name = M-&Graphics
type = gdf
typename = M-Graphics Files
exepath = C:\Program Files\Johnson Controls\M-Graphics\Gwx32.exe
exeparam = -Runtime
docpath = C:\Documents and Settings\All Users\Application Data\Johnson Controls\M-Data\M-Graphics
alias = NET,SYS
delim = \n
[M-Trend]
name = M-Tr&end
type = htv
typename = M-Trend Files
exepath = C:\Program Files\Johnson Controls\M-Trend\M-Trend.exe
exeparam =
docpath = C:\Documents and Settings\All Users\Application Data\Johnson Controls\M-Data\M-Trend

[M-ScrMgr]
name = Screen &Manager
type = pwf
typename = ScreenManager Files
exepath = C:\Program Files\Johnson Controls\Screen Manager\ScrMgrBar.exe
exeparam =
docpath = C:\Documents and Settings\All Users\Application Data\Johnson Controls\M-Data\Screen Manager
```

Figure 3-2: Example of M-Bind.ini File
Detailed Procedures

Binding a Component File

To bind a component file:

1. On the Network Map, select a network, group, or system.
2. On the Action menu, click Component Binding. The Component Binding dialog box appears (Figure 3-3).

3. Select the Component Name from the Bindable Components drop-down list. If a binding exists for the selected item, a file name appears in the File name edit box; otherwise, this field is blank.

4. Enter a component file or click Browse. The Component Document Browser dialog box appears (Figure 3-4). The component files located in the component default directory are listed.

Figure 3-3: Component Binding Dialog Box

Figure 3-4: Component Document Browser Dialog Box
5. Select the component file to bind or enter a file name.

Note: If you are using either Microsoft® Windows® 2000 Professional or Windows XP Professional operating systems, the File > Open command does not work for the M-Graphics or the M-Trend Bindable Components. The path specified in the M-Bind.ini file does not open. To find the specified file, browse to the correct location.

6. Click Open. This returns you to the Component Binding dialog box with file name entered. If the file entered does not exist, the Copy Creation dialog box appears (Figure 3-5).
7. To make a copy of an existing file, select a file from the Create copy of: drop-down list and click OK. The dialog box closes and the Component Binding dialog box appears (Figure 3-3). The copied file is placed in the default directory.

8. Click OK to bind the file to the selected item and close the dialog box. Click Apply to create multiple component bindings to the same Network Map item. Multiple bindings must be made from different components. For example, you cannot bind two files of the same component (sample1.htv and sample2.htv) to the same network item.

**Performing a Fast Bind**

To perform a Fast Bind:

1. On the Network Map, select a network, or multiple groups, or systems. To select multiple items, click and drag over items on Network Map or shift-click on Network Map items.

2. On the Action menu, select Component Binding. The Fast Component Binding dialog box appears (Figure 3-6).

![Figure 3-6: Fast Component Binding Dialog Box](image)

3. Select the component name from the Bindable Components drop-down list box.

   Note: The File name text box is always blank on this screen.

4. Enter a component file name or click Browse to open the Component Document Browser (Figure 3-4) to locate and select a file.

5. Choose one of the two following options:

   - Click OK to bind the file to the selected Network Map items and close the dialog box.
Click Apply to bind the file and leave the Fast Component Binding dialog box (Figure 3-6) open. Use Apply to create multiple component bindings to the same item.

Notes: Multiple bindings must be made from different components. For example, you cannot bind two files of the same component (sample1.htv and sample2.htv) to the same network item.

Fast Bind, in conjunction with M-Graphics which provides an aliasing capability, allows multiple Metasys systems to be associated to the same M-Graphics file. This requires that the only difference is the system portion of the fully qualified system name. All objects associated with the systems must be named the same.

The component binder passes two aliases to the M-Graphics file based on the system that is currently selected on the Network Map.

For example, if the current item on the Network Map is St. Pats\1stfloor\ahu-1, the Component Binder passes two aliases, NET=St_Pats and SYS=ahu-1, to the graphics application during the loading process.

To see an example of how aliases are used in an M-Graphics picture, see the file alias.gdf. This file is installed with the M5 Workstation. It is located in the M-Graphics subdirectory.

**Launching a Component**

To launch a component:

1. Select an item on the Network Map.
2. On the Network Map menu, select Components > M-Graphics (or other component).
3. If a component binding exists, the component is launched and the component file is displayed. If a component binding does not exist, the following dialog box appears:
Figure 3-7: Launching a Component without a Bound File Screen

4. Click Yes to proceed with component binding function. Click No to cancel. Refer to the Binding a Component File section in this chapter.

Note: The choice to bind the item in Figure 3-7 is available based on the user’s Metasys system access level.

Removing a Component File Binding

To remove a component file binding:

1. On the Network Map, select a network, group, or system.
2. On the Action menu, click Component Binding. The Component Binding dialog box appears (Figure 3-8).

Figure 3-8: Removing Binding to a Component File Dialog Box

3. Select component from Bindable Components drop-down list box. The bound component file appears in the File name text box.
4. Click Delete to remove binding to the file.
Removing Multiple Component File Bindings

To remove binding to multiple Network Map items:

1. On the Network Map, select multiple networks, groups, or systems. To select multiple items, click and drag over items on the Network Map.
2. On the Action menu, click Component Binding. The Component Binding dialog box appears.
3. Select component from Bindable Components drop-down list box.
4. Click Delete to remove bindings from the file. The bound component file does not appear in the File name text box. To verify that the bound component file is deleted, select each item individually.

Removing Metasys (Micrografx) Graphics Bindings

Note: Micrografx is not supported with Metasys system Release 11.00 or later software, but the Micrografx files can still be used.

To remove Metasys system graphics bindings from Network Map objects:

1. Select an item on the Network Map.
3. Click OK. The binding to the file is removed and the files are renamed as follows:
   - *.drw renamed to *.drb
   - *.dbf renamed to *.dbb

This menu item is enabled only if the graphics option set in the .ini file is both Micrografx and M-Graphics, and if a Micrografx Binding currently exists. If only M-Graphics is set in the .ini file, the Remove Metasys Graphics Bindings menu item is not available.
Modifying an Existing Component

To modify an existing component:

1. Select SetUp > Component Binding Configurator. The Component Configurator dialog box appears (Figure 3-9).

![Figure 3-9: Component Configurator Dialog Box](image)

2. The first component defined in the Metasys.ini file appears in the Component Names text box. Select other components by clicking the arrow in this box and scrolling down. The component’s properties are displayed.

3. Modify any of the component property entries and click OK when finished. A message appears confirming the components have been added, deleted, or modified.

4. Click OK and restart the Metasys system to update the Network Map.
Adding a New Component

To add a new component:

1. Select SetUp > Component Configurator. The Component Configurator dialog box appears (Figure 3-9).

2. Click Add. The entry fields are cleared. Enter new component information. All fields except Command Line Parameters and Default Directory Path are required.

3. Click OK when finished. A message appears confirming the components have been added, deleted, or modified.

4. Click OK and restart the Metasys system to add Component Names to the Network Map.

Duplicate component menu names cannot be added.

Deleting an Existing Component

To delete an existing component:

1. Select SetUp > Component Configurator. The Component Configurator dialog box appears (Figure 3-9).

2. Select the component in the Component Names drop-down list box.

3. Click Delete. The component is removed from the M-Bind.ini file and does not appear in the Component Menu Name text box.

4. Click OK. A message appears confirming the components have been added, deleted, or modified.

5. Click OK and restart the Metasys system to remove the component name from the Network Map.
Adding a New Component

To add a new component:

1. Select SetUp > Component Configurator. The Component Configurator dialog box appears (Figure 3-9).

2. Click Add. The entry fields are cleared. Enter new component information. All fields except Command Line Parameters and Default Directory Path are required.

3. Click OK when finished. A message appears confirming the components have been added, deleted, or modified.

4. Click OK and restart the Metasys system to add Component Names to the Network Map.

Duplicate component menu names cannot be added.

Deleting an Existing Component

To delete an existing component:

1. Select SetUp > Component Configurator. The Component Configurator dialog box appears (Figure 3-9).

2. Select the component in the Component Names drop-down list box.

3. Click Delete. The component is removed from the M-Bind.ini file and does not appear in the Component Menu Name text box.

4. Click OK. A message appears confirming the components have been added, deleted, or modified.

5. Click OK and restart the Metasys system to remove the component name from the Network Map.
Chapter 4

Using Screen Manager

Introduction

Screen Manager is the principal method of interfacing with the M5 Workstation.

This chapter describes how to:

- launch Screen Manager
- log in to M5 Workstation via M-Password
- log out of M5 Workstation via M-Password
- launch layouts or select templates
- create a custom template
- renumber panels in a new template
- populate a layout
- modify panel properties
- save a panel layout
- realign a panel layout
- launch layouts from the Recent list
- register new applications
- delete existing applications
- modify application launch properties
- modify Screen Manager properties
- set up the alarm icon path in Screen Manager
- dock the Screen Manager command bar
- float the Screen Manager command bar
- minimize the Screen Manager command bar
• activate Metasys® OWS (with Autologin)
• activate Metasys OWS (without Autologin)
• control Screen Manager panels via M-Graphics pick actions
• exit M5 Workstation
Key Concepts

M-Password

Screen Manager is the main navigational and operational mechanism for the M5 Workstation. Management of users, groups, and privileges is handled by M-Password.

Prior to logging in for the first time, users must be configured using M-Password. M-Password allows you to define users, assign users to groups, and set user level privileges and group level privileges.

User level privileges override group privileges. By default, when a new user is added, the new user has all the available privileges, and privileges must be removed from the user until the required level of functionality has been defined.

Note: M-Password contains a Default Group, and all users are automatically members of this group. Edit the Default Group to allow all users only minimum privileges. Failure to edit the Default Group gives all users all privileges.

Use M-Password to:
- add a new user
- set user password
- set user default layout
- set user language preference
- add a new group
- assign privileges to a user
- assign privileges to all users
- assign privileges to a group
- assign a user to a group
- remove a user from a group
- delete a user
- delete a group

For complete information on M-Password functionality, refer to M-Password Technical Bulletin (LIT-1153150) and M-Password Application Actions Technical Bulletin (LIT-1153175).
Metasys Operator Workstation (OWS) Integration

The M5 Workstation provides a link to the Metasys OWS via Screen Manager. When Metasys OWS is installed, the Metasys button on the Screen Manager command bar is the only link to the Metasys system.

Metasys Autologin

If the M5 Workstation is configured with Metasys Autologin, a single password logs into both the M5 Workstation and the Metasys system. Once configured, clicking the Metasys button on the Screen Manager command bar displays the Network Map.

If the Metasys password is not identical to the M5 Workstation password, Autologin fails. If this happens, clicking the Metasys button on the Screen Manager command bar displays the Metasys Login screen.

See Appendix C: Metasys OWS Autologin (LIT-1153894) in this guide for more information.

Metasys Manual Login

If the M5 Workstation is not configured with Metasys Autologin, the user may log in to the Metasys system manually at any time.

Metasys Button

After logging into Screen Manager and the Metasys system with the Autologin feature, you may access the Network Map by clicking on the Metasys button on the Screen Manager command bar.

Metasys Logout

Four methods of logging out of Metasys OWS are available:

- explicit logout via M-Password
- changing users via the Exit menu
- M-Password timeout (only if autologin is enabled. Refer to the M-Password Technical Bulletin (LIT-1153150) for more information.
- OWS timeout

Screen Manager Logout

Logging out of Screen Manager automatically logs out of M5 Workstation. For additional information, see Logging Off an M5 Workstation in the Getting Started on the M5 Workstation (LIT-1153820) chapter of this manual.
Templates

Screen Manager templates are empty Screen Manager layout files without applications defined. Templates provide the empty framework to organize applications on your screen. The Screen Manager Data directory contains a set of templates used to create layouts.

Although you cannot change the number of panels in an existing template, you can create new templates from scratch, using the New button on the Templates and Layouts list. You can also create new templates from existing templates by modifying the relative size of the panels in Runtime mode, and saving it as a new template.

Application Files

Application files are data files displayed in the panels of Screen Manager. Application files are not restricted to a specific storage location, and can include standard third-party applications, such as Microsoft® Word and Excel and Johnson Controls® applications such as M-Graphics, M-Trend, etc.

Add data directories to Screen Manager using variables in the Screen Manager properties page called Include1, Include2, Include3, up to Include100. Each of these variables contains the path for a data file. All data files in the specified path are then available for use with Screen Manager. Use the Application Browser to browse for application data files. See Registering New Applications in this chapter for additional information.

To search subdirectories of the specified data directories for data files, check the Include Sub Directories check box on the Screen Manager Properties Dialog Box (Figure 4-15). If this check box is not checked, Screen Manager will look only in the root of the data directory.

Note: For optimum results, do not configure applications assigned to Screen Manager layouts or templates to display maximized. If applications configured within a Screen Manager layout or template are saved to display maximized, then the Screen Manager may continuously lose focus, or panels may not resize properly. This is especially true for the M-Graphics application which has the capability of configuring a display to launch maximized. Not all applications have the capability to configure this display property.

Layouts

A layout file is a template file with applications added. Each layout file launches its applications at the specified screen locations.
Panel

Panel size and position are determined during template configuration. When a layout file is loaded, each panel displays its predefined applications.

Screen Manager Command Bar

The Screen Manager command bar allows the user to treat several applications as a single desktop display. The Screen Manager command bar provides functional support for controlling application window desktop locations, window style properties, window launch properties, changing displays, and providing access to available applications (Figure 4-1).

Figure 4-1: Screen Manager Command Bar

When minimized, the command bar icon is displayed on the Windows® taskbar.

Thumbnail Window

The Thumbnail window reflects the current panel layout and visually identifies the placement of each panel. Empty panels are white and populated panels are cyan (light blue). If no layout is loaded, the Thumbnail window is dark gray. The file name of the currently loaded template or layout file appears as the label beneath the thumbnail display. Screen Manager appends an asterisk to the file name if the layout has been modified.

Save Button

The Save button appears on both the command bar (only when the command bar is floating) and the Layouts list. Functionality of the Save button is the same from both locations. The Save button saves the current layout or template as a new file with the extension .pwf.

Alarm Indicator

The Alarm Indicator provides a user configurable visual and audible indication of the system’s current alarm state. When a new alarm is detected, the alarm indicator flashes and beeps. Refer to the M-Alarm User’s Guide for more information.
**Layouts Button**

The Layouts button displays the Layouts list, which includes all layout and template (empty layout) files found in the current project directory. Launch layouts by selecting them from within this list.

**Applications Button**

Screen Manager defines a collection of available data directories (maximum 100) such as M-Graphics, M-Trend, or third-party applications (such as Excel, Word), which may be dragged and dropped into available panels. The Applications list allows users to browse the available files.

**Recent Button**

The Recent button displays a list of the last ten viewed layouts. When a configured layout or template is launched, it is added to this list. Layouts can be recalled from the Recent list.

**M-Explorer**

M-Explorer is a client application that communicates with Object Linking and Embedding (OLE) for Process Controls (OPC) Data Servers using standard protocols. M-Explorer displays online objects similar to the way Windows Explorer displays directories (folders) and files. Refer to *M-Explorer User’s Guide* for additional information.

**Metasys OWS**

When installed, access Metasys OWS from the command bar by clicking on the Metasys button. If Autologin for Metasys OWS is configured and the passwords for both the M5 Workstation and Metasys systems match, clicking on the Metasys button displays the Network Map. If Autologin is not configured, or if the passwords do not match, Autologin cannot automatically log into Metasys OWS. In this case, clicking the Metasys button displays the Metasys Login panel.

**Screen Manager Properties**

Screen Manager includes a Properties page for configuration (Figure 4-15). See Table 4-4 for a list of available properties and a brief description of their purposes. See *Modifying Screen Manager Properties* in this chapter for information on how to set these properties.
Template/Layout File Naming Conventions

The template files supplied with the M5 Workstation installation have a common naming convention which includes the number of monitors and the number of panels in the name. To differentiate similar configurations, some files include one of the following additional letters at the end of the name:

- **h**=horizontal
- **v**=vertical
- **b**=bottom
- **t**=top
- **l**=left
- **r**=right

For example, XmonYpn1.pwf indicates that this file is configured for X number of monitors and Y number of panels. 3mon5pn1h.pwf indicates this file is designed for 3 monitors, 5 panels, horizontal.

The M5 Workstation installation includes template/layout files for one, two, and three monitor configurations.

Windows Taskbar

The command bar minimizes to an icon on the Windows taskbar.

Multiple Monitor Support

Screen Manager supports multiple monitors in the Windows 98 or Windows 2000 operating system. For detailed instructions on how to set up multiple monitor displays, refer to C:\Windows\display.txt. on Windows 98 and the Windows Help on Windows 2000 operating system.

Screen Manager requires the primary display for multiple monitor implementation to be the left hand display, the second and third (if desired) are configured from left to right (i.e., [1] [2] [3]). All monitors must be set to the same resolution.

Slide Show

The Slide Show feature allows Screen Manager to display a repeating series of layouts when no user is logged into M-Password. If a Slide Show is defined in the Screen Manager Properties display, the Default Layout is disabled. If neither Default Layout or Slide Show is defined, Screen Manager loads without an initial layout. For additional information on the Slide Show feature, see Appendix D: Screen Manager Slide Show (LIT-1153896) in this manual.
Note: The Slide Show is not supported on the Windows 98 platform.

Default Layout

The Default Layout specifies the layout file to be loaded prior to logging into the M-Password. The Default Layout is not used if the Slide Show feature is enabled. To use Slide Show, do not define a Default Layout.

Controlling Screen Manager via M-Graphics Pick Actions

Screen Manager can be controlled via M-Graphics Pick Actions. Pick Actions specified in M-Graphics can cause Screen Manager to:

- load layout files
- open an application in the next available panel
- open an application in a specified panel
- load a new layout

Typically, the Pick Action in M-Graphics specifies a directory path. In this case, the directory path points to the Screen Manager executable file:

C:\Program Files\Johnson Controls\Screen Manager\ScrMgrBar.exe.

Additional control over Screen Manager is available by using switches in the command line. See Table 4-1 for examples of switches that can be used.

Table 4-1: Command Line Switches

<table>
<thead>
<tr>
<th>Switch</th>
<th>Resulting Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; No Switch Used &gt;</td>
<td>Screen Manager loads with no initial layout.</td>
</tr>
<tr>
<td>Drive:\Path\Layout File</td>
<td>Screen Manager loads with the specified file as the initial template or layout. If Screen Manager is already loaded, the current layout is closed and the specified layout is loaded.</td>
</tr>
<tr>
<td>\Display1.gdf</td>
<td>Screen Manager loads Display1.gdf into the first available panel.</td>
</tr>
<tr>
<td>\Display1.gdf, -runtime</td>
<td>Screen Manager loads Display1.gdf into the first available panel in Runtime mode.</td>
</tr>
<tr>
<td>\Display1.gdf, -runtime, 3</td>
<td>Screen Manager loads Display1.gdf into panel number 3, in Runtime mode.</td>
</tr>
</tbody>
</table>
For example: in System.gdf, an Air Handler Unit (AHU) has an embedded pick action associated. When the user clicks the AHU, the embedded code:
C:\Program Files\Johnson Controls\Screen Manager\ScrMgrBar.exe OutsideAir.xls, 2 is run. This embedded code launches the specified file (OutsideAir.xls) in Screen Manager’s Panel 2, within the currently running layout. If an application is currently running in Panel 2, it closes immediately prior to loading OutsideAir.xls.

**OPC Universal Tag Browser**

The OPC Universal Tag Browser allows you to configure OPC data points and lists currently connected Tags.

**Note:** The following limitation exists in the OPC Universal Tag Browser: The Item ID field remains blank until an attribute of that object is selected. To select only the object and not the attribute, select an attribute of that object and delete the attribute name in the Item ID field. Refer to the *Establishing Data Source Connections (LIT-6440100)* chapter in the *M-Graphics User’s Manual* for more information.

**OWSEexec**

The OWSEexec provides an interface to the Metasys system. Using M-Graphics, Metasys OWS command dialog boxes and windows can be displayed while logged into Metasys. A Pick dynamic is added to an M-Graphic display causing the corresponding window or dialog box to launch when the pick action is clicked. M-Graphics passes the command and object name to Metasys using OWSEexec as an interface between the two applications.

**Note:** OWSEexec is available only when the Metasys system is installed.

**Tag**

All non-numeric data connection strings that do not include special tokens are interpreted as Tags. Tags represent a value in the system. Refer to the *Establishing Data Source Connections (LIT-6440100)* chapter in the *M-Graphics User’s Manual* for more information.
Detailed Procedures

Launching Screen Manager

To launch Screen Manager:

From the Windows Start Menu, select Programs > Johnson Controls > M5. The Screen Manager command bar appears (Figure 4-2).

Figure 4-2: Screen Manager Command Bar

Notes: Without logging on, you may interact with M5 Workstation as the Default User. In this case, you may execute all actions for which the Default User is configured.

See M-Password Technical Bulletin (LIT-1153150) and M-Password Application Actions Technical Bulletin (LIT-1153175) for details on configuring the Default User.

Logging In to the M5 Workstation via M-Password

Note: Users and passwords must be defined before completing this procedure.

To log in to the M5 Workstation via M-Password:

1. From the Screen Manager command bar, click Logon. The Johnson Controls M-Password Login dialog box appears (Figure 4-3).

Figure 4-3: Johnson Controls M-Password Login Dialog Box

2. Enter your User Name and Password.

3. Click OK.
Logging Out of M5 Workstation via M-Password

To log out of M5 Workstation via M-Password:

1. On the Screen Manager command bar, click Logon. The Johnson Controls M-Password Login window (Figure 4-4) appears.

Note: When a user is logged into M5 Workstation, the Logon label on the Screen Manager command bar is replaced with the logon ID of the logged in user.

2. On the User menu, click Logout.

3. To exit M-Password, on the User menu, click Exit.

Managing Alarm and Event Messages

Unacknowledged alarm and event messages consume memory (RAM), which may lead to system lockups of the M5 Workstation, and can result in PC crashes. Unattended M5 Workstations can quickly accumulate a critical number of unacknowledged events, if message acknowledgment is not managed properly.

To manage alarm and event messages:

1. Close M-Alarm event views on unattended workstations, as the client application memory use grows as events are reported. For example, M-Graphics memory use grows continuously if M-Alarm event views are embedded in M-Graphics displays.
2. Delete Screen Manager alarm indicator subscriptions on unattended workstations so that they are not signed up to any OPC AE Server by doing the following:
   a. Right-click on the bell icon, and click Properties from the pop-up menu.
   b. Select the Subscription tab.
   c. Highlight the server, and click Delete.

To improve performance on attended sites, modify the subscription to remove the default event types (simple and tracking), as the icon does not use them. This modification should improve the performance of the M5 Workstation. See Chapter 9 of the M-Alarm User’s Guide, Advanced User’s Guide (LIT-11537545).

Configuring the Alarm Indicator

To configure the alarm indicator:
1. Right-click on the alarm indicator icon.
2. Select Properties. For more information refer to the M-Alarm User’s Guide.

Launching Layouts or Selecting Templates

To launch layouts or select templates:
1. From the Screen Manager command bar, click on the Layouts button.
2. The Layouts list appears (Figure 4-5).

3. Select the required template or layout displayed in the Templates or Layouts lists.
Note: If the selected layout has populated panels (a populated panel is cyan, an unpopulated panel is white), the associated applications are displayed in their respective screen panels. On the Screen Manager command bar, the thumbnail window reflects the configuration and population of the selected layout. If the layout is not populated, refer to *Populating a Layout* in this chapter.

Creating a Custom Template

To create a custom template:

1. From the Screen Manager command bar, click on Layouts. The Layouts list appears (Figure 4-5).
2. Click New. The Template Creation window appears (Figure 4-6).

![Figure 4-6: Template Creation Window](image)

3. Select one of the panels displayed in the Template Creation window.
4. Right-click the selected panel.
5. From the displayed short-cut menu, choose one of the available options: Split left and right, Split top and bottom, Delete panel, or Renumber panels, according to your requirements.

Note: You can also resize a panel by highlighting it and moving its borders to the required location.

6. Once the layout is complete, click Save.
Note: Your Layout file can only have up to eight panels with M-Graphics files open at one time in Screen Manager.

Renumbering Panels in a New Template

Note: Panels may be renumbered only during the creation of a custom template. Panels in pre-existing templates cannot be renumbered.

To renumber panels in a new template:
1. Create a new template. See Creating a Custom Template in this chapter for additional information.
2. Right-click the template in the Template Creation window.
3. From the displayed Shortcut menu, choose Renumber Panels. The numbering sequence is removed from the configured panels.
4. Click the configured panels in the order you wish them to be numbered, starting from Number 1.
5. Once the layout is complete, click Save.

Populating a Layout

To populate a layout:
1. From the Screen Manager command bar, click the Applications button. The Applications list appears (Figure 4-7).

![Figure 4-7: Applications List](image)
2. Select the required application or file and drag it into the desired panel on either the thumbnail window or the main screen.

Note: When you drag an item from the Applications list onto the desktop, panel gridlines display that correspond to the boundaries of the current template.

3. If an application is already assigned to that panel, a message box appears (Figure 4-8).

![Screen Manager Message Box](Figure 4-8: Screen Manager Message Box)

4. Click Yes to update the panel with the new application or file. Click No to retain the existing panel application.

**Modifying Panel Properties**

To modify panel properties:

1. From the Screen Manager command bar, right-click on the Thumbnail window. The Panel Selection dialog box appears (Figure 4-9).

![Panel Selection Dialog Box](Figure 4-9: Panel Selection Dialog Box)

2. Click on the panel to be modified. The Screen Manager - Panel Properties dialog box appears (Figure 4-10).
Figure 4-10: Panel Properties Dialog Box

3. Modify the parameters. Refer to Table 4-2.

4. Click OK.
### Table 4-2: Panel Properties

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application Specifications</strong></td>
<td></td>
</tr>
<tr>
<td>Data File Spec</td>
<td>Name of the application document assigned to the panel. Click the ellipsis button at the right to browse for the required file.</td>
</tr>
<tr>
<td>Command Line</td>
<td>Additional switches used to control application launch. These switches are specific to the application being launched.</td>
</tr>
<tr>
<td>Default Directory</td>
<td>Default directory for the application assigned to the panel. This directory is configured by the installation procedure. If required, click the ellipsis button at the right to browse for a new default directory.</td>
</tr>
<tr>
<td>Test</td>
<td>Tests the newly modified panel layout before clicking OK</td>
</tr>
<tr>
<td><strong>Window Specifications</strong></td>
<td></td>
</tr>
<tr>
<td>Panel No.</td>
<td>Panel number for the selected panel, specified by the template</td>
</tr>
<tr>
<td>Panel Priority</td>
<td>Currently, this priority is not used.</td>
</tr>
<tr>
<td>Default Panel</td>
<td>Enables this panel to serve as the default panel. If all other panels are loaded and a new data file is launched automatically (via double-clicking in the Application Browser), it closes the application in the default panel and loads the new application there.</td>
</tr>
<tr>
<td>Enable Custom Window Styles</td>
<td>Enables the Custom Window Styles section of the dialog</td>
</tr>
<tr>
<td>Note: Custom Window Styles are not available with Windows 98 SE.</td>
<td></td>
</tr>
<tr>
<td>Title Bar</td>
<td>Enables display of the Title Bar</td>
</tr>
<tr>
<td>System Menu</td>
<td>Enables display of the System menu for the application assigned to individual panel</td>
</tr>
<tr>
<td>Minimize Capability</td>
<td>Enables the minimizing feature for the application assigned to individual panel</td>
</tr>
<tr>
<td>Maximize Capability</td>
<td>Enables the maximizing feature for the application assigned to an individual panel</td>
</tr>
<tr>
<td>Transparent if Empty</td>
<td>Selects whether to show placeholder application in empty panels or leave them empty</td>
</tr>
<tr>
<td>Sizable Window</td>
<td>Enables the resizing feature for the window</td>
</tr>
<tr>
<td>Always on Top</td>
<td>Always displays the window on top. This prevents the window being overlaid.</td>
</tr>
<tr>
<td>Disable User Input</td>
<td>Prevents the entering of any input.</td>
</tr>
<tr>
<td>Note: If Disable User Input is selected, some applications may remain open when Screen Manager is closed. In this case, do not select Disable User Input.</td>
<td></td>
</tr>
<tr>
<td>Top</td>
<td>Enter a number (pixels) to reposition and move the window for the application assigned to selected panel.</td>
</tr>
<tr>
<td>Left</td>
<td>Enter a number (pixels) to reposition and move the window for the application assigned to selected panel.</td>
</tr>
<tr>
<td>Right</td>
<td>Enter a number (pixels) to reposition and move the window for the application assigned to selected panel.</td>
</tr>
<tr>
<td>Bottom</td>
<td>Enter a number (pixels) to reposition and move the window for the application assigned to selected panel.</td>
</tr>
</tbody>
</table>

Note: To save changes to the panel properties, use the Panel Properties dialog box. If you resize panels on the screen, the panels revert to their original size when you realign or close the layout.
Saving a Panel Layout

To save a panel layout:

1. From the Screen Manager command bar, click Save (Figure 4-11).

   ![Figure 4-11: Save Button](image)

2. The My Save As dialog box appears.

   ![Figure 4-12: My Save As Dialog Box](image)

3. Enter a new file name, or select an existing file name.
4. Click OK.

Realigning a Panel Layout

To realign a panel layout:

From the Screen Manager command bar, click anywhere within the Thumbnail window. The current display realigns to the original position and contents.
Launching Layouts from the Recent List

To launch a layout from the Recent list:

1. From the Screen Manager command bar, click the Recent button. The Recent List appears (Figure 4-13).

![Figure 4-13: Recent List](image)

2. Click on a layout.
3. Click Open.

Registering New Applications

To register a new application:

1. Right-click on the gray background area of the Screen Manager command bar.
2. From the displayed Shortcut menu, select Screen Manager Properties. The Screen Manager Properties dialog box appears (Figure 4-15).
3. Using the Forward and Backward buttons in the Default Data Directories frame, navigate to the next available location (Include1 to Include100). See Figure 4-15.
4. Specify the directory path of the required application documents.
5. Click OK.
6. Exit and relaunch Screen Manager.

Note: For additional information on registering new applications, see Modifying Screen Manager Properties in this chapter.
Deleting Existing Applications

To delete an existing application:

1. Right-click on the gray background area of the Screen Manager command bar.

2. From the displayed Shortcut menu, select Screen Manager Properties. The Screen Manager Properties dialog box appears (Figure 4-15).

3. Using the Forward and Backward buttons in the Default Data Directories frame, navigate to the application to be deleted (Include1 to Include100).

4. Clear the directory path of the required application.

5. Click OK.

6. Exit and relaunch Screen Manager.

Modifying Application Launch Properties

To modify application launch properties:

1. From the Screen Manager command bar, click on the Applications button. The Applications list appears (Figure 4-7).

2. In the Applications list, right-click on the application to be modified. The Screen Manager - Application Launch Properties dialog box appears (Figure 4-14).

3. Fill in the fields as required. Refer to Table 4-3.

Figure 4-14: Screen Manager - Application Launch Properties Dialog Box

3. Fill in the fields as required. Refer to Table 4-3.
### Table 4-3: Application Launch Properties Parameters

<table>
<thead>
<tr>
<th>Launch Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>Displays name of the selected application.</td>
</tr>
<tr>
<td>Application Alias</td>
<td>Alternative name (alias) to be used in Application Browser, list boxes, etc.</td>
</tr>
<tr>
<td>File Specification</td>
<td>Enter file specification information in the text box to provide information about the location of an executable file. Click the button on the right to browse for a particular file using the Locate File Specification dialog box. If a specific file is selected within the dialog to modify the default, the information is automatically entered in the File Specification box.</td>
</tr>
<tr>
<td>Command Line</td>
<td>Enter a command line to modify application launch properties (e.g., enter <code>-runtime</code> for M-Graphics to start applications in Runtime mode).</td>
</tr>
<tr>
<td>Default Directory</td>
<td>Displays default directory location. Click the button on the right to browse directories using Locate File Specification dialog. This box may be set to modify the directory default.</td>
</tr>
<tr>
<td>Test</td>
<td>Tests the application launch properties prior to saving edits.</td>
</tr>
</tbody>
</table>

4. Click OK.

Note: Test the Applications Launch Properties by clicking the Test button.
Modifying Screen Manager Properties

To modify Screen Manager properties:

1. Right-click on the Screen Manager command bar in the background area. The Screen Manager Shortcut menu appears.

2. Select Screen Manager Properties. The Screen Manager Properties dialog box appears (Figure 4-15).

3. Set the properties as required, and click OK.

Note: Any settings entered into the upper frame (Default Data Directories) require the M5 Workstation software to be closed and reloaded prior to taking effect. Settings entered in the lower frame (Command Bar Functionality) take effect immediately, without requiring the M5 Workstation software to be reloaded.
Note: Settings entered in the Screen Manager Properties display are saved in the ProjInfo.ini file. Using this display is the recommended method of maintaining the settings stored in the ProjInfo.ini file. See Table 4-4 for additional information about setting Screen Manager Properties.

Table 4-4: Screen Manager Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Data Directories</td>
<td>100 user-defined directory paths that Screen Manager searches for application data files</td>
</tr>
<tr>
<td>Include Sub Directories</td>
<td>Allows Screen Manager to search all subdirectories below each of the 100 defined directory paths</td>
</tr>
<tr>
<td>Ignore Unknown Extensions</td>
<td>Allows Screen Manager to ignore all file types not registered with the operating system</td>
</tr>
<tr>
<td>Ignore File Extensions</td>
<td>A user-defined list of file extensions to be ignored by Screen Manager</td>
</tr>
<tr>
<td>Tool Tips</td>
<td>Allows Screen Manager to display a fly-over help label that identifies items on the command bar. You must hold the mouse pointer over an item for a couple of seconds for the label to appear.</td>
</tr>
</tbody>
</table>
| Labels                    | Allows Screen Manager to display labels below the buttons on the command bar. Note: Button labels are disabled when any of the following conditions is met:  
  ✓ screen resolution of 800 x 600, Logon label also disabled when command bar is in vertical position  
  ✓ screen resolution of 1024 x 768 (or greater) and command bar is floating |
| Lock Command Bar Position | Prevents the user from docking or undocking the command bar                  |
| Auto Hide                 | Allows Screen Manager to automatically hide the command bar when not in use. To display the command bar, you must move the mouse cursor to the edge of the screen where the command bar is docked. This property does not work when the command bar is in floating mode. |
| Always On Top             | Allows the command bar to always remain on top, and it cannot be hidden by other windows on top of it. |
| Default Layout when no one is logged in: | Allows Screen Manager to always display the Default View after loading until there is a successful login. The ellipsis button to the right of the text box can be used to browse for a default view layout. |
| Use Slide Show            | Allows Screen Manager to display a Slide Show after loading until there is a successful login. The Default View feature is unavailable if there is a Slide Show defined. See SlideShow.txt in Appendix D: Screen Manager Slideshow (LIT-1153896) of this guide for additional information. |
**Setting Up the Alarm Icon Path in Screen Manager**

To set up the alarm icon path in Screen Manager:

1. Right-click on the Alarm Icon on the Screen Manager command bar. The Screen Manager Shortcut menu appears.

![Figure 4-16: Alarm Icon Right-Click Menu](image)

2. Select Launch Doc (Figure 4-16). The ActiveX® Control Properties dialog box appears.

3. Select the Settings tab.

4. Insert the path to the .exe file in `Doc to launch`.

5. After the .exe file path, put the actual file name in quotes.

6. Add `runtime` at the end of the file name. Refer to Figure 4-17 for the Alarm Icon path and file in Screen Manager.
Docking the Screen Manager Command Bar

To dock the Screen Manager command bar:

1. Click on the background area of the floating Screen Manager command bar.

2. Drag the cursor to the edge of the screen while holding the mouse button down. The Screen Manager command bar snaps to the edge of the screen.

Note: If the Lock Command Bar Position is checked in the Screen Manager Properties dialog box (Figure 4-15), a docked command bar cannot be moved, and a floating command bar cannot be docked.
Floating the Screen Manager Command Bar

To float the Screen Manager command bar:

1. From the docked Screen Manager command bar, click on the background area.
2. While holding the mouse button down, drag the cursor from the edge of the screen into the center. The Screen Manager command bar detaches from the edge of the screen and floats in the middle (horizontally only).

Note: The command bar cannot be docked or undocked if the Lock Command Bar Position is set (via Screen Manager Properties).

Minimizing the Screen Manager Command Bar

To minimize the Screen Manager command bar:

1. Right-click on the Screen Manager command bar background area. The Shortcut menu displays.
2. Choose Minimize.

Or,

1. Right-click on the Windows taskbar Screen Manager icon. The Shortcut menu displays.
2. Choose Minimize.

Or, if the Screen Manager command bar is floating, click the Minimize icon in the upper right-hand corner of the command bar.
Activating Metasys OWS (with Autologin)

To activate Metasys OWS (with Auto-login):

From the Screen Manager command bar, click on the Metasys button. The Network Map appears.

For more information about Metasys Auto-login, see the *M5 Workstation* and *Metasys OWS Integration* sections earlier in this chapter.

Activating Metasys OWS (without Autologin)

To activate Metasys OWS (without Autologin):

1. From the Screen Manager command bar, click on the Metasys button. The Metasys login screen appears.
2. Enter the Metasys password and click OK.

Controlling Screen Manager Panels via M-Graphics Pick Actions

To control Screen Manager panels via M-Graphics pick actions:

2. Run Screen Manager (M5 Workstation).
3. Load a layout file that includes the M-Graphics file.
4. Click on the object in the M-Graphics file that has the Pick action associated with it.

Note: Your Layout file can only have up to 8 panels with M-Graphics files open at one time in Screen Manager.
Exiting M5 Workstation

To exit M5 Workstation:
1. Right-click on the Screen Manager icon in the System Tray.
2. Click Commands.
3. Click Exit. Refer to Table 4-5.

Or,
1. Right-click on the background area of the Screen Manager command bar.
2. From the displayed Shortcut menu, choose Exit.

Table 4-5: Screen Manager Icon Shortcut Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td>Exits Screen Manager</td>
</tr>
<tr>
<td>Screen Manager Properties</td>
<td>Displays the Properties dialog box</td>
</tr>
<tr>
<td>Minimize View</td>
<td>Minimizes the Screen Manager command bar to the Windows taskbar</td>
</tr>
<tr>
<td>Restore View</td>
<td>Restores the Screen Manager command bar</td>
</tr>
<tr>
<td>Help</td>
<td>Displays M5 Help</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Shortcut menu</td>
</tr>
</tbody>
</table>
Troubleshooting

Logon Attempt Fails – Invalid User

If a logon attempt fails and Screen Manager displays the Invalid User message, the user may not be listed in the M-Password Configuration utility.

Run the M-Password Configuration utility and configure the user.

Logon Attempt Fails – Invalid Password

If a logon attempt fails and Screen Manager displays the Invalid Password message, the user may not have the password set in the M-Password utility according to user expectations.

Run the M-Password Configuration utility; configure and confirm the user’s password.

Logon Attempt Fails – User is Disabled

If a logon attempt fails and Screen Manager displays the User is Disabled message, the user may have been disabled in the M-Password Configuration utility.

Run the M-Password Configuration utility and configure the user’s enabled/disabled state.

Closing the M5 Workstation Software Does Not Close All Applications

If closing the M5 Workstation software does not close all its associated applications, these applications may not respond to the Close message.

Check that Disable User Input is not selected in Panel Properties.

Unable to Float or Dock Screen Manager Command Bar

If the Screen Manager command bar does not float or dock as required, verify that the Lock Command Bar Position check box is unchecked (Figure 4-15). See Modifying Screen Manager Properties in this chapter for more information.
Buttons Unavailable on Screen Manager Command Bar

If some buttons are unavailable (grayed out) from the command bar, check the available functionality in M-Password.

Check that the unavailable features are available from M-Password. See M-Password Technical Bulletin (LIT-1153150) and M-Password Application Actions Technical Bulletin (LIT-1153175) for more information.

Check that Slide Show is not running.

Not Authorized Message on Startup

If the Not Authorized message appears when starting M5 Workstation, the temporary authorization period may have expired or temporary authorization may not have been enabled.

See Using M-Authorize Technical Bulletin (LIT-6424400) for more information.

Layout Errors

If a layout is experiencing errors when loading, verify that the files displayed in each panel are located in the path specified in the Panel Properties. Use the Test button on the Panel Properties to check the operation of each panel.
Chapter 5

M-Graphics

Introduction

Through the dynamic color M-Graphics component, users can easily glide through buildings, floors, Heating, Ventilating, and Air Conditioning (HVAC) systems, and related systems through simple point-and-click actions.

This chapter describes how to launch a Metasys window or dialog box from M-Graphics.

See the *M-Graphics User’s Manual* for further information.
Key Concepts

M-Graphics Features

The M-Graphics component provides:

- a full-featured online graphics editor
- a library of symbols with prebound tags - just modify the alias name to change the binding reference
- multifaceted zooming
- animation
- color gradients and fills
- diagnostic trend graphs
- the ability to launch/interact with other applications such as documents that list sequences of operation or provide diagnostic assistance
- versatile import capabilities that allow Windows Metafile (.wmf), bitmaps, and digital images to be the basis of any graphical display

Data Source Connections

A data source connection is a Tag representing:

- a value in the system
- a constant value
- a local M-Graphics variable
- an alias
- a mathematical expression (which can include Tags, constants, and local variables).

For more information about data source connections, refer to the Establishing Data Source Connections (LIT-6440100) chapter of the M-Graphics User’s Manual.
OPC Universal Tag Browser

The OPC Universal Tag Browser allows you to configure OPC data points and lists currently connected Tags.

Note: The following limitation exists in the OPC Universal Tag Browser: The Item ID field remains blank until an attribute of that object is selected. To select only the object and not the attribute, select an attribute of that object and delete the attribute name in the Item ID field. Refer to the Establishing Data Source Connections (LIT-6440100) chapter in the M-Graphics User’s Manual for more information.

OWSEexec

The OWSEexec application provides an interface to the Metasys system. Using M-Graphics, Metasys OWS command dialog boxes and windows can be displayed while logged into the Metasys system. A Pick dynamic is added to an M-Graphic display causing the corresponding window or dialog box to launch when the pick action is clicked. M-Graphics passes the command and object name to the Metasys system using OWSEexec as an interface between the two applications.

Note: OWSEexec is available only when the Metasys system is installed.

Property Inspector

The Property Inspector allows you to view and change object parameters.

Related Information

Table 5-1: Related Information

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binding Components</td>
<td>Binding Components (LIT-1153840) chapter of this guide</td>
</tr>
<tr>
<td>Ordering Information</td>
<td>M-Graphics Product Bulletin (LIT-6420060)</td>
</tr>
</tbody>
</table>
Detailed Procedures

Launching a Metasys Window or Dialog Box from M-Graphics

To add a pick dynamic:
1. Select a graphic symbol.
2. Double-click on the graphic symbol.

Or,

From the M-Graphics menu, select Dynamics > Actions > Pick. The Property Inspector dialog box (Figure 5-1) appears.

![Property Inspector Dialog Box](image)

Figure 5-1: M-Graphics Property Inspector Dialog Box
3. Click the Custom button to display the OWSExec Command Editor dialog box.

Note: This dialog box only appears when the active property page in the Property Inspector dialog box is Pick and the Pick Action field is set to Launch Application. If either of these conditions is not met when the Custom button is clicked, a message box will inform the user appropriately.

![OWSExec Command Editor dialog box](Figure 5-2: OWSExec Command Editor Dialog Box)

### Table 5-2: OWSExec Command Editor Dialog Box Components

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metasys Application</td>
<td>Type of command dialog box to display (Table 5-3)</td>
</tr>
<tr>
<td>OWSExec Command Line</td>
<td>Current command line for OWSExec as it will be inserted into the File Name field of the Property Inspector dialog box</td>
</tr>
<tr>
<td>Browse</td>
<td>Displays the OPC Universal Tag Browser which allows the user to browse through the N1 network, systems, or objects to find the required object name</td>
</tr>
<tr>
<td>OK</td>
<td>Saves the current OWSExec command line and inserts it into the File Name field of the Property Inspector dialog box (Figure 5-1)</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Command Editor dialog without saving the current OWSExec command line</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the Help file for this application</td>
</tr>
</tbody>
</table>

4. Select the Metasys Application from the drop-down list.

5. Click Browse to display the OPC Universal Tag Browser.

6. Select the required object name. The Item ID field in the OPC Universal Tag Browser remains blank until an attribute of that object is selected. To select only the object and not the attribute, select an attribute of the object, then delete the attribute name in the Item ID field. Refer to the *Establishing Data Source Connections (LIT-6440100)* chapter in the *M-Graphics User’s Manual* for more information.
Note: Group names cannot be selected with the Tag Browser, they must be entered manually on the OWSExec command line.

7. Click OK to save.

Note: Alternately, complete the File Name field in the Property Inspector dialog box (Figure 5-1) using the information in Table 5-3. For more information about adding dynamics, refer to the *M-Graphics User’s Manual*.

When the graphic is in Runtime mode and the designated mouse button is clicked on the graphic, the defined Metasys window or dialog box displays.

### Table 5-3: Property Inspector Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Type of dynamic action in Runtime.</td>
<td>Launch Application</td>
</tr>
<tr>
<td>Mouse</td>
<td>Mouse button that starts the action in Runtime.</td>
<td>Right Button</td>
</tr>
<tr>
<td>File Name</td>
<td>Name and path of action in Runtime.</td>
<td>Format of the command is OWSExec.exe xxx, full object reference, where xxx is the command listed in Table 5-4 and full object reference is the full object reference as found on the Network Map. In Figure 5-2, the command is OWSExec.exe foc, hdqtrs\west\nc6-dx_1\ai-4, xxx=foc and the full object reference = hdqtrs\west\nc6-dx_1\ai-4.</td>
</tr>
<tr>
<td>Custom Data</td>
<td>Displays OWSExec Command Editor dialog box.</td>
<td>Refer to Figure 5-2.</td>
</tr>
</tbody>
</table>
### Table 5-4: OWSExec Pick Action Application Parameter Options

<table>
<thead>
<tr>
<th>Command</th>
<th>Metasys Item</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CMD</strong></td>
<td>Fully Qualified Object Name</td>
<td>Object Operation Dialog Box</td>
</tr>
<tr>
<td></td>
<td>Network or Fully Qualified Group or System Name</td>
<td>None</td>
</tr>
<tr>
<td><strong>FOC</strong></td>
<td>Fully Qualified Object Name</td>
<td>Object Focus Window</td>
</tr>
<tr>
<td></td>
<td>Network</td>
<td>Network Focus Window</td>
</tr>
<tr>
<td></td>
<td>Fully Qualified Group or System Name</td>
<td>OBJECT_NOT_FOUND; the focus window initialization failed</td>
</tr>
<tr>
<td><strong>SCH</strong></td>
<td>Fully Qualified Object Name</td>
<td>Object Scheduling Window</td>
</tr>
<tr>
<td></td>
<td>Network or Fully Qualified Group or System Name</td>
<td>Network, Group, or System Scheduling Window</td>
</tr>
<tr>
<td><strong>TRE</strong></td>
<td>Fully Qualified Object Name</td>
<td>Object Trend Window</td>
</tr>
<tr>
<td></td>
<td>Network or Fully Qualified Group</td>
<td>Cannot Access Data</td>
</tr>
<tr>
<td></td>
<td>Fully Qualified System</td>
<td>System Trend Window</td>
</tr>
<tr>
<td><strong>TOT</strong></td>
<td>Fully Qualified Object Name</td>
<td>Object Totalization Window</td>
</tr>
<tr>
<td></td>
<td>Network or Fully Qualified Group</td>
<td>Cannot Access Data</td>
</tr>
<tr>
<td></td>
<td>Fully Qualified System Name</td>
<td>System Totalization Window</td>
</tr>
<tr>
<td><strong>HIS</strong></td>
<td>Fully Qualified Object Name</td>
<td>Object History Window</td>
</tr>
<tr>
<td></td>
<td>Network or Fully Qualified Group</td>
<td>Cannot Access Data</td>
</tr>
<tr>
<td></td>
<td>Fully Qualified System</td>
<td>System History Window</td>
</tr>
<tr>
<td><strong>ALM</strong></td>
<td>Fully Qualified Object Name</td>
<td>Object Alarm Summary Window</td>
</tr>
<tr>
<td></td>
<td>Network or Fully Qualified Group or System Name</td>
<td>Network, Group, or System Summary Window</td>
</tr>
<tr>
<td><strong>CRI</strong></td>
<td>Network or Fully Qualified Group or System or Object Name</td>
<td>Network Critical Window</td>
</tr>
<tr>
<td><strong>CAL</strong></td>
<td>Network or Fully Qualified Group or System or Object Name</td>
<td>Network Schedule Calendar Window</td>
</tr>
<tr>
<td><strong>MGX</strong></td>
<td>Fully Qualified Object Name</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Network or Fully Qualified Group or System Name</td>
<td>Micrografx drawing</td>
</tr>
<tr>
<td><strong>SUM</strong></td>
<td>Network or Fully Qualified Group or System of Object Name</td>
<td>Summary Window</td>
</tr>
<tr>
<td><strong>DAY</strong></td>
<td>Network or Fully Qualified Group or System or Object Name</td>
<td>Network Map Daylight Saving Window</td>
</tr>
</tbody>
</table>
Chapter 6

N1 Trend Collector

N1 Trend Collector retrieves historical data from the Metasys® N1 network subsystem through the Metasys Remote Server (MRS). As the N1 Trend Collector receives data from the Metasys system, it stores the data in an M-Historian database. M-Trend is used to view the stored data.

M-Historian is designed to provide storage of historical trend data for a number of different network subsystems. The M-Historian archives historical trend data and provides standard interfaces for data retrieval for client applications such as M-Trend. These standard interfaces allow the use of any client application that can connect to an Open Database Connectivity (ODBC) data source.

This chapter describes the N1 Trend Collector and how to:

- configure a trend collection
- enable trend collection for Metasys N1 objects
- display the N1 Trend Collector application window
- define the USER_APP file destination
- define Analog Data (AD) Points and Binary Data (BD) Points for Historian node monitoring
- enable offline node detection
- disable offline node detection

This document may contain information about discontinued features or products. This information is for reference only. Beginning with Release 5.4, the following features or products are no longer supported:

- AspenTech® InfoPlus.21® Historian
- ARCNET® protocol
- Microsoft® Windows® 98 and Windows NT® operating systems
Point History (This feature has limited functionality on the Windows XP Professional operating system. See the Point History Reports section for details. Also, refer to Metasys Software Installation and Platform Requirements Technical Bulletin [LIT-12012].)
Key Concepts

N1 Trend Collector

The N1 Trend Collector interfaces with the Metasys N1 network to receive trend and point history data. N1 Trend Collector stores its configuration information into user files, referred to as trend collection definitions (*.tcd files). The collected data is stored in one or more of the installed M-Historian databases. The N1 Trend Collector can reside on any machine, including those that do not have Metasys software installed.

The N1 Trend Collector collects data from a Metasys network via a connection to the MRS. The connection between the N1 Trend Collector and the MRS can be local or remote. A local connection means the N1 Trend Collector and the MRS are located on the same computer. A remote connection means the collector and server are located on different computers on an Ethernet-based network. N1 Trend Collector receives Trend and/or Point History reports from the MRS, using the USER_APP file definition feature. See Figure 6-1.

Note: Remote connections are not supported on ARCNET® based networks. If Ethernet is not available, the N1 Trend Collector and MRS must reside on the same computer. This situation also applies to the M-Trend application.
N1 Trend Collector Specifications

Refer to Table 6-1 for N1 Trend Collector specifications.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Points in a Scan</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>Maximum Points in a Scan</td>
<td>5000</td>
<td>100</td>
</tr>
<tr>
<td>Minimum Fast Scan Rate</td>
<td>20 seconds</td>
<td>60</td>
</tr>
<tr>
<td>Maximum Fast Scan Rate</td>
<td>1200 seconds</td>
<td>60</td>
</tr>
<tr>
<td>Minimum Number of Samples in a Display</td>
<td>0</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td>At 0 samples in a display, the display is effectively disabled.</td>
<td></td>
</tr>
<tr>
<td>Maximum Number of Samples in a Display</td>
<td>5000</td>
<td>500</td>
</tr>
</tbody>
</table>

N1 Trend Collector Configuration Options

A trend collection can only connect with a single MRS. To collect data from an additional MRS, you must define an additional trend collection. This also applies to M-Historian databases. To store trend data in separate databases, you must define a separate trend collection for each database.

Note: Do not configure more than one trend collection to write to a single Microsoft® Access database.

Multiple trend collections can be defined on a single computer. This allows you to collect data from multiple network nodes and view the data on the same computer. Multiple trend collections can also connect to a single MRS. This allows more than one workstation to be populated with the same data. Use this feature to allow multiple users in different locations to collect and view data from the same network node.

Typically on an Ethernet network, one computer is set up with a single N1 Trend Collector configured to collect data from one MRS and store data in one M-Historian database. If Ethernet is not available, the N1 Trend Collector and M-Historian database must be installed on each M5 Workstation that requires data viewing. Table 6-2 details the supported databases for the N1 Trend Collector.
### Table 6-2: Supported Databases for the N1 Trend Collector

<table>
<thead>
<tr>
<th>Considerations</th>
<th>Access Historian</th>
<th>InfoPlus.21 Historian</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Platform</strong></td>
<td>Supported with M3 Workstation, M5 Workstation, and MWA</td>
<td>Supported with M3 Workstation and M5 Workstation</td>
</tr>
<tr>
<td><strong>Target Job Size</strong></td>
<td>Small jobs (&lt;0.5 GB storage/year) No tag size restrictions</td>
<td>Larger jobs (&gt;0.5 GB storage/year) Option for 1,000 tags, 10,000 tags, and 50,000 tags</td>
</tr>
<tr>
<td><strong>Performance</strong></td>
<td>Low-performance database management system</td>
<td>High-performance database management system</td>
</tr>
<tr>
<td><strong>Operating System Support for the ODBC Driver</strong></td>
<td>Remote access not possible</td>
<td>Remote access possible with client driver installation on Windows 98 and Windows NT</td>
</tr>
<tr>
<td><strong>Maximum Database Size</strong></td>
<td>Limited to 1 GB</td>
<td>Limited to the amount of free disk space and by the initial setup of InfoPlus.21 Historian database</td>
</tr>
<tr>
<td><strong>Vertical Market Focus</strong></td>
<td>No specific vertical market focus</td>
<td>No specific vertical market focus</td>
</tr>
<tr>
<td><strong>Tag Name Format</strong></td>
<td>NETNAME. SYSNAME. OBJNAME# ATTRNAME</td>
<td>NETNAME. SYSNAME. OBJNAME# ATTRNAME</td>
</tr>
<tr>
<td><strong>Time Zone of Time Stamps</strong></td>
<td>Local</td>
<td>Local</td>
</tr>
</tbody>
</table>
Figure 6-2: N1 Ethernet with AspenTech InfoPlus.21 Historian

In Figure 6-2, a number of M5 Workstations are interconnected via an Ethernet-based network. MRS with Person-Machine Interface (PMI) in Workstation A is connected to the N1 Trend Collector in Computer B. To access a database on a network, the network must use Ethernet topology, each client must have Transmission Control Protocol/Internet Protocol (TCP/IP) and InfoPlus.21 Client (ODBC Driver) installed. You can load the Client on as many workstations as needed. If the Trend Collector and MRS reside on different machines, they must be connected using an Ethernet network.
**Note:** In the Metasys system for Validated Environments (MVE) configuration, the N1 Trend Collector resides on the Client Collector Server and communicates across the Ethernet to the FX-Historian Database.

If one of the workstations is running a Windows NT operating system, both the AspenTech InfoPlus.21 Historian and the Microsoft Access databases may be installed on a single Windows NT computer.

In Figure 6-3, an ARCNET based solution uses Microsoft Access for the M-Historian database. Since there is no Ethernet network in this solution, the machines cannot communicate with each other using TCP/IP. To access and view archived trend data, each Metasys workstation must have PMI and M5 Workstation software installed. This installation allows the connection with the N1 Trend Collector locally, M-Trend, and Access Historian database are also installed locally.

**Note:** Like any Microsoft Access database, the Access Historian database is limited to a maximum size of one gigabyte. In practice, the database size should be fewer than 500 megabytes, because as it grows, the database write time delays may become excessive.
Figure 6-4: N1 Ethernet with Microsoft Access Database

In Figure 6-4, an Ethernet based solution uses Microsoft Access for the M-Historian database. To access and view archived trend data, each workstation must have PMI and M5 workstation software installed. This allows the connection of MRS with the N1 Trend Collector locally. M-Trend and Access Historian database are also installed locally.

**Note:** Like any Microsoft Access database, the Access Historian database is limited to a maximum size of one gigabyte. In practice, the database size should be fewer than 500 megabytes, because as it grows, the database write time delays may become excessive.
Figure 6-5: N1 ARCNET Using AspenTech InfoPlus.21 Historian

In Figure 6-5, an ARCNET based N1 Network uses an Ethernet network to provide communication between AspenTech InfoPlus.21 Historian database and AspenTech InfoPlus.21 Historian clients. In this case, each M5 Workstation that uses M-Trend to display archived trend data requires both ARCNET and Ethernet network adapters.
Data Security

To ensure the security of collected and archived trend data, observe the following precautions:

- Keep regular backups of database files.
- Do not allow the customer’s Information Technology (IT) department to do a full backup of the InfoPlus.21 Server without either shutting down the database manager or excluding the specific critical InfoPlus.21 files from the backup process.
- Ensure the stability of power supplied to all M5 Workstation hardware components including the computer on which the InfoPlus.21 Historian database is running.
- Use an Uninterruptible Power Supply (UPS) to prevent sudden power loss.
- Use the proper shutdown procedure every time the power is to be shut off on all computers with M5 Workstation software including InfoPlus.21 Historian database software running.

M-Historian Database Component

The M-Historian component provides storage for historical data in either an AspenTech InfoPlus.21 database or Microsoft Access database format. You can install and use both databases on one machine. For more information about the M-Historian component, refer to the M-Historian Overview Technical Bulletin (LIT-646100).

Metasys Remote Server (MRS)

The MRS is a Metasys system communication interface that is being provided with PMI software to the Metasys system. The MRS forwards information from the PMI report destination USER_APP to the N1 Trend Collector. The N1 Trend Collector stores that information in an M-Historian database. The MRS is installed via the Metasys system Operator Workstation (OWS) PMI Software installation and is activated by the M5 Workstation software.

For trend collection purposes, only one MRS is required to be active on a Metasys N1 network. However, there are several reasons for activating MRS on more than one computer running PMI software:

- to store data from different USER_APP Report Access Groups into separate Historian databases (see Figure 6-6)
- to collect data from more than one Metasys N1 network that is defined on a Wide Area Network (WAN)
- if the message load exceeds the capacity of one MRS
The MRS receives Trend and Point History reports from the Metasys system using the USER_APP reports definition. USER_APP is a special file report destination that applications may use to receive report data (for example, Metalink or MetaPage® applications). To receive all Metasys system trend data from all Metasys system Report Groups, define a file destination with the name USER_APP. You must define this file destination for the Trend or History category under the required report access groups on the PMI to which the N1 Trend collector is connected. (The choice between Trend or History file destination depends on your requirements.)

![Diagram of MRS Multiple Systems](image)

**Figure 6-6: Multiple Systems Running MRS**

**Note:** If more than one trend collection is defined to write to the same database, you may be unable to identify the source of each sample.
USER_APP File Destination

The Metasys system uses the USER_APP file destination to enable the routing of reports to client applications. Client applications may include Metalink DDE clients and MRS clients. MRS clients include N1 OPC Server and N1 Trend Collector. You must configure these custom clients (USER_APP).

For more information on configuring the USER_APP file destination, refer to the Defining the USER_APP File Destination section later in this chapter.

Point History Reports

The Point History reports store samples of the VALUE attribute for all monitored points every 30 minutes and whenever a point’s status changes. Only the attributes compatible with the database are stored with each sample (for example, date, time, status, and value).

By default, samples created from Point History reports are stored using the same Tag Name as the one used for the VALUE attribute of trend samples. If required, samples created from Point History reports can be stored using a different Tag Name from the Trend samples. Point History samples can be stored under the Tag Name network.system.object#PHValue, if required.

Notes: This counts against the InfoPlus.21 total tag limit. Therefore, if you intend to use separate tag names for PH value, ensure you purchase the correct InfoPlus.21 tag size.

Point History functionality is limited with the Windows XP Professional operating system. See the following details:

- Point History reports for analog objects (Analog Data [AD], Analog Input [AI], ACM [Accumulator], Analog Output [AO]) are not archived to PC file destinations.
- Duplicate object entries occur in the PC file destination for Point History reports from Analog Data (AD) objects.
- Possible problems occur when reading the Point History archive data from the PC file destination.
Fast Scan

Fast Scan mode collects data at more frequent intervals than the standard 30 minute interval for Point History reports. If Fast Scan mode is enabled, it is activated whenever a point goes into alarm. When an analog Point History report is triggered and received, the N1 Trend Collector checks to see if it has gone into alarm. If it is in alarm, the point is put into Fast Scan mode. In Fast Scan mode, the point is sampled at a user-configurable interval. This interval is set during configuration of the N1 Trend Collector. Each read value creates a sample and stores it in the M-Historian database. The time stamp used for each sample is the N1 Trend Collector’s local clock synchronized to the server’s clock on the Metasys system. For more information, see Figure 6-7.

Figure 6-7: Fast Scan Time Stamp Generation

To minimize the impact on performance, the points in Fast Scan mode are kept in a Fast Scan list. The number of points serviced in this list is limited by the user-configurable maximum. The default maximum value is 100. This value can be modified in the Options dialog box of the N1 Trend Collector. If the value is 100, the Fast Scan algorithm generates reports for the first 100 points in alarm. Any point beyond 100 is in a wait-state. When a point from the first 100 is removed from Fast Scan mode, all points numbered higher than the removed point are moved up by the N1 Trend Collector. This feature allows you to control the impact on performance by decreasing the number of serviced points in Fast Scan mode, if necessary.
Boolean point type objects (such as light switches) are not fast scanned since their value toggles between two states. If one value causes the object to go into alarm, then Point History reports are automatically generated.

Configure Fast Scan through the N1 Trend Collector configuration options. Fast scan samples appear in the N1 Trend Collector view as FastScan in the Report Type column.

**Point Status**

The N1 Trend Collector can store the status of each Point History sample received from the Metasys system. The Point History Status is a numeric value ranging from 0 to 6; refer to Table 6-3. The value currently being reported is stored in the database using a Tag Name with the format network.system.object#PHStatus.

**Note:** This counts against the InfoPlus.21 total tag limit. Therefore, if you intend to use separate tag names for PH value and Point History Status, ensure you purchase the correct InfoPlus.21 tag size.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Normal</td>
</tr>
<tr>
<td>1</td>
<td>Trouble</td>
</tr>
<tr>
<td>2</td>
<td>Alarm (Binary)</td>
</tr>
<tr>
<td>3</td>
<td>Low Warning</td>
</tr>
<tr>
<td>4</td>
<td>Low Alarm</td>
</tr>
<tr>
<td>5</td>
<td>High Warning</td>
</tr>
<tr>
<td>6</td>
<td>High Alarm</td>
</tr>
</tbody>
</table>

**Trend Reports**

If more frequent sampling is required than Point History reports can provide, use the Trend feature. Samples created from Trend reports are stored with the Tag Name format, network.system.object#attrname. You may specify the interval at which reports are collected from the N1 network subsystem. Trend reports also can deliver information on any numerical attribute of the monitored points.

For example, if the N1 Trend Collector monitored a programmable thermostat, the Trend report could include the VALUE attribute (the value of the temperature it is currently sensing), and the SET_POINT attribute (the value at which the thermostat is set). This allows building operators to monitor whether the thermostat’s SET_POINT is changing as it is programmed, or if it is being manually reset.
N1 Trend Collector Application Window

The application window shows the status of the connection and the most recent samples received from the Metasys system. The Collection Viewer has a fixed size that is defined in the N1 Trend Collector Configuration Options dialog box (Figure 6-13). The default value is 500. The view is treated as a circular buffer, which means that when the last line is filled, the N1 Trend Collector begins displaying the most recent reports at the top. The next line to be replaced is marked with an underscore in the Number column.

Once the N1 Trend Collector has demonstrated it is functioning correctly, the sample value of zero prevents the N1 Trend Collector from negatively impacting system performance.

Note: If a Trend report contains more than one sample, only the first sample from the report appears in the application window.

Figure 6-8: N1 Trend Collector Application Window
### Table 6-4: N1 Trend Collector Application Window Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Exit</td>
<td>Terminates the Trend Collector application and stops data collection.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Options</td>
<td>Displays the N1 Trend Collector Configuration Options screen (Figure 6-13). Refer to the Configuring a Trend Collection section of this chapter for more information.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Status Bar</td>
<td>When checked, displays Windows status bar.</td>
</tr>
<tr>
<td></td>
<td>Statistics</td>
<td>Displays performance-related data. The information displays in a dialog box and also is written to the N1 Trend Collector’s log file when the application is manually terminated or the system is shut down. Average Write time for the AspenTech InfoPlus.21 Historian database is 0-10 milliseconds. Average Write time for the Access database is 30-70 milliseconds.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>About Trend Collector</td>
<td>Displays N1 Trend Collector information, including version number.</td>
</tr>
</tbody>
</table>

### Table 6-5: N1 Trend Collector Application Window Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Time sample was taken</td>
</tr>
<tr>
<td>Tag Name</td>
<td>Full Tag Name, representing an object attribute in the system</td>
</tr>
<tr>
<td>Reliable</td>
<td>Sample reliable, Y or N (Yes or No)</td>
</tr>
<tr>
<td>Value</td>
<td>Value of sample</td>
</tr>
<tr>
<td>Type</td>
<td>Analog or binary</td>
</tr>
<tr>
<td>PT Status</td>
<td>Point History Status. Refer to Table 6-3.</td>
</tr>
</tbody>
</table>
| Write-Status| Database Write Status  
0 = OK  
-1 = Not selected for storage  
Any other value indicates an error. Refer to Table 6-11. |
| Write Time  | Time in milliseconds it took to store the sample  
30-70 ms average Write Time |
System Tray Icon

An icon displays in the Windows System Tray once the trend collection session is configured and running. When the cursor is held over the icon, N1 Trend Collector and the name of the session display.

![N1 Trend Collector System Tray Icon](image)

**Figure 6-9: N1 Trend Collector System Tray Icon**

Right-clicking on the icon displays the options listed in Table 6-6.

**Table 6-6: N1 Trend Collector Icon Shortcut Menu Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection Viewer</td>
<td>Displays Trend Collector application window.</td>
</tr>
<tr>
<td>Edit Options</td>
<td>Displays N1 Trend Collector Configuration Options dialog box (Figure 6-13). Used to change Trend Collector configuration options. Refer to the Configuring a Trend Collection section of this chapter for more information.</td>
</tr>
<tr>
<td>View Statistics</td>
<td>Displays performance related data. The information displays in a dialog box and also is dumped to the trend collector’s log file when the program is manually terminated or the system is shut down.</td>
</tr>
<tr>
<td>About</td>
<td>Displays N1 Trend Collector information, including version number.</td>
</tr>
<tr>
<td>Terminate</td>
<td>Terminates the Trend Collector session. A dialog box displays to confirm the termination.</td>
</tr>
</tbody>
</table>

Historian Node Monitoring

The Historian Node stores all the Point History data.

This optional feature allows the Metasys system to detect trouble with the Historian node (an offline condition or problems with database Write operations) and the communication links between the network controller level that is generating historical data and the N1 Trend Collector.

Define all Node Monitor points on a single NCM within the Metasys Network. The points are divided into two different functional components: watchdog functionality and error handling functionality. A sample Data Definition Language (DDL) file contains all the required point definitions. You can modify the system and object names, if required, however we recommend that you use the default names. Modify the Network Controller (NC) to contain these points. Specify two points, one AD and one BD, in the Configuration Options of the N1 Trend Collector. The default names in configuration options match those in the sample DDL definitions.
If monitoring a single node with a single trend collector, use the default object names supplied in the DDL. However, you must define additional sets of points (one for each node or collection) to monitor additional nodes or collections. The best method for defining an additional set of points is to copy the default set and rename the System name.

**Note:** If a new Node monitor feature (M5 5.1A or later) is installed on top of older versions of the Node monitor feature, make sure the old node monitor JC-BASIC process (datahist.bas) is deleted from the archive OWS and Historian Node Monitor NC.

**Online/Offline Node Detection via Watchdog**

One set of points is responsible for monitoring the online/offline status of the N1 Trend Collector. Define one BD point (HISTAT2) in the Configuration Options dialog box.

A watchdog functionality was implemented using a Multiple Command Object (WATCH_TC) and two BD points (HISTAT and HISTAT2) for monitoring the online status. Once per minute, the N1 Trend Collector writes a watchdog value (0) to the HISTAT2 BD object. If the collector is unable to write the value within a minute and a half, an offline condition is triggered. The Multiple Command Object (MCO) has an adjustable default value of one and a half minutes. The delay may need to be lengthened on some projects.

The HISTAT object generates a Critical Alarm value of **OFFLIN** or **ONLINE** when an offline or online condition is triggered. Figure 6-10 details the watchdog functionality.
Under normal conditions the N1TC task writes a \( 0 \) (Normal) to the HISTAT2 (BD) point approximately 1/minute. This status then triggers the WATCH_TC (MC) object to send commands to the HISTSTAT and HISTAT2 objects. When the WATCH_TC object sees the signal from the N1TC, it forces the HISTAT2 point back into the wait state which in turn triggers the WATCH_TC to command HISTSTAT to OFFLINE (after a 1 1/2 minute delay). If the N1TC fails to write to HISTAT2 point within the next 1 1/2 minutes (adjustable in WATCH_TC), the previous command timer expires and a \( 0 \) is sent to the HISTSTAT (BD) point which has an output of CRIT1. CRIT1 indicates the OFFLINE state to the operator. A return to Normal has an output of a CRIT4 message.

Table 6-7 lists the slave commands for the WATCH_TC (MC) point.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Slave</th>
<th>Command</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>If state = 0 (N1TC) then:</td>
<td>HISTSTAT</td>
<td>Set_BD, 1, 3</td>
<td>Put the HISTSTAT point to ONLINE (NORMAL) state.</td>
</tr>
<tr>
<td></td>
<td>HISTAT2</td>
<td>Set_BD, 1, 3</td>
<td>Put the HISTAT2 point to WAIT state.</td>
</tr>
<tr>
<td>If state = 1 (WAIT) then:</td>
<td>HISTSTAT</td>
<td>Set_BD, 0, 3 w/Delay</td>
<td>Put the HISTSTAT point to OFFLINE (ALARM) state after 00:01:30.*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>* This only occurs if the N1TC can not get back to write a 0 within the 1 1/2 minute time frame.</td>
</tr>
</tbody>
</table>
**M-Historian Database Error Handling Functionality**

The other set of points are responsible for handling M-Historian database Error functionality. Two points are defined for this functionality: a single AD object (DATASTAT) and a single BD object (DBMS_ERR).

**DATASTAT (AD)**

If value > 0 = ALARM

N1TC Task
(N1 Trendcollector.exe)

1/minute send the DBMS write status to the DATASTAT (AD)

**DBMS_ERR (BD)**

Associated input = DATASTAT.H1_ALARM

- On Alarm (state 1)
- Output CRIT1
- OnNORMAL (state 0)
- Output CRIT4

Under normal conditions, the N1 Trend Collector writes a 0 (Normal) write status to the DATASTAT (AD) point approximately once per minute. If a DBMS write error occurs, the first error value is stored and sent to the DATASTAT (AD) as a positive integer value when the N1 Trend Collector’s next minute write time occurs. The DATASTAT point has a high limit of one. If the report router is configured to output a CRIT1 to a user device, the error # is annunciated to the user. These write error #s are documented in the Special Error Codes section. In addition to the analog alarm, a DMBS_ERR binary point is defined to clearly annunciate DB OK or DB ERR.

**Figure 6-11: Historian Node Monitoring–DBMS Error**

The Node Monitor mechanism captures the following errors:

- If the N1 Trend Collector cannot communicate with the N1 network and the defined Watchdog BD (HISTAT2), then the HISTSTAT BD object goes into the OFFLINE (ALARM) state.

- If problems occur within the M-Historian database and consequently the N1 Trend Collector cannot write to the database, then the first DBMS write error is annunciated to the user as a High Alarm on the DATASTAT (AD) object. The N1 Trend Collector continues to send the current error code to the DATASTAT (AD) object every minute until the DBMS error has been corrected.

**Note:** Check the errors in the order they appear above.
ODBC

ODBC is an acronym that stands for Open Database Connectivity. The ODBC Application Programming Interface (API) allows client applications to store and retrieve data using a standardized interface. Client and server applications may be installed on different computers and may use different operating systems.

Related Information

Using M-Historian in the M5 Workstation requires setting up several pieces of software to work together. For information on the software and tasks involved, see the documents listed in Table 6-8.

Table 6-8: N1 Trend Collector Related Information

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing M5 Workstation</td>
<td>M5 Workstation Installation Technical Bulletin (LIT-1153300)</td>
</tr>
<tr>
<td>Enabling Point History</td>
<td>Operator Workstation User’s Manual</td>
</tr>
<tr>
<td>Viewing Trend Data</td>
<td>M-Trend User’s Manual</td>
</tr>
</tbody>
</table>
Detailed Procedures

Configuring a Trend Collection

To configure a trend collection:

1. Verify the MRS is running, either locally, or remotely.

Notes: Refer to Verifying the Operation of the Metasys Remote Server in the Troubleshooting section for additional information.

M-Password control is available for controlling access to the configuration of the N1 Trend Collector. Users may be restricted from creating new definitions and from making modifications to existing definitions. This prevents unauthorized users from terminating a collection. The N1 Trend Collector generates an event log when creating a new collection or modifying an existing collection.

2. From the Windows Start menu, select Programs > Johnson Controls > N1 Trend Collector. The N1 Trend Collector Setup screen (Figure 6-12) appears.

![N1 Trend Collector Setup](image)

Figure 6-12: N1 Trend Collector Setup Screen

3. Select the Local option to connect to a local MRS. To connect to a remote MRS, select the Remote option, and specify an IP address and port number. Refer to Table 6-9.
### Table 6-9: N1 Trend Collector Setup Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Name</strong></td>
<td>Name of the file where configuration options are stored. This name must contain valid file name characters and describe where the MRS is located. The name is not restricted to eight characters and may contain spaces. If you are defining more than one trend collection on the same computer, you must use a different name for each connection (for example, OWS1).</td>
</tr>
<tr>
<td><strong>IP Address</strong></td>
<td>IP number of remote machine. The IP address is not required when connecting locally.</td>
</tr>
<tr>
<td><strong>Metasys Remote Server Location</strong></td>
<td>Option for either local or remote location. A local connection means the N1 Trend Collector and the Metasys Remote Server are located on the same computer. A remote connection means the N1 Trend Collector and Metasys Remote Server are located on different computers on an Ethernet-based network.</td>
</tr>
</tbody>
</table>
| **Port Number**        | The port number is predefined. In most situations, the default TCP/IP port number (24688) should remain. Only change this number if a conflict exists with another application that is using the same port number. If it is necessary to change this number, you must first change the port number within the Metasys Remote Server. To do this, modify or add the following parameter to the [METAHOST] section of the METAHOST.INI file:  
  
  MetahostPort=nnnnn  
  
  Where nnnnn is a TCP/IP port number. Once this is done, proceed with the N1 Trend Collector setup and enter the same port number in this dialog box. |

4. Click Connect. If the connection is not successful, a message appears and the N1 Trend Collector Setup dialog box reappears. If this happens, verify the MRS is running on the computer to which you are connecting and you have entered the correct IP address. The N1 Trend Collector queries the MRS for a list of all Metasys Network names. When a response is received, the N1 Trend Collector Configuration Options screen appears (Figure 6-13).

**Note:** To verify if MRS is running, check the Windows Task Manager for Metasrvr. If Metasrvr is not present in the Task List, restart the M5 Workstation.
5. Enter the required configuration options. Refer to Table 6-10 for detailed field descriptions. Select the Metasys Networks from which you wish to receive reports. For storage of the trend samples, you must select one of the available Historian Server databases, either Microsoft Access or AspenTech InfoPlus.21 Historian. Select the appropriate database by selecting the associated ODBC Data Source. Choose the Data Source Name (DSN) that you entered during installation. The default name for the standard ACCESS based historian is MSAccess Historian and the default name for the InfoPlus.21 Historian is AspenTech. The TrendSample DSN is a sample database and should not be selected for storing samples. Click OK. The N1 Trend Collector dialog box appears.
Table 6-10: N1 Trend Collector Configuration Options Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metasys Networks</td>
<td>Lists names of all Metasys Networks accessible by the MRS. Typically this list includes the name of an N1 network but may also list NC Direct and PC Dial network names.</td>
</tr>
<tr>
<td>Storage</td>
<td>Determines type of trend information storage. Specify the ODBC DSN that you specified during installation. Do not select the TrendSample DSN.</td>
</tr>
<tr>
<td>Collection Viewer</td>
<td>Determines maximum number of samples to display in the collector window.</td>
</tr>
<tr>
<td>Trend Report Processing</td>
<td>Enables and disables collection of trend reports from the Metasys system for storage in Historian database. Does not affect trend collection. This feature can be disabled when you only want Point History.</td>
</tr>
<tr>
<td>Point History Report Processing</td>
<td>Enables storing point's value attribute and status change. Default Point History Tag format is network.system.object#attrname. Enable Point History reporting in the Metasys system.</td>
</tr>
<tr>
<td>Use Trend Tag Name</td>
<td>When selected, the Point History Tag Name is network.system.object=Value. When not selected, the Point History Tag Name is network.system.object#PHValue. This feature allows you to store Point History and Trend data separately by using two different Tag Names.</td>
</tr>
<tr>
<td>Store Status</td>
<td>Enables storing the status of each Point history sample received from the Metasys system. The Point History Status is a numeric value: 0 = Normal 1 = Trouble 2 = Alarm (Binary) 3 = Low Warning 4 = Low Alarm 5 = High Warning 6 = High Alarm This Tag format is network.system.object#PHStatus.</td>
</tr>
<tr>
<td>Fast Scan Enabled</td>
<td>Enables Fast Scan mode. When a point goes into alarm, the point is sampled at an interval defined in this dialog box while the point is in alarm. Each read value is a sample used for creating a sample in the database. The points in Fast Scan mode are kept in a Fast Scan list with a maximum number of points defined in this dialog box. Refer to Table 6-1 for details about settings for the Fast Scan mode.</td>
</tr>
<tr>
<td>History Mode Monitor Check box</td>
<td>Enables node monitor feature for trend collection. This feature enables alarms when data is not stored in a M-Historian database. Refer to Historian Node Monitor section above for more information.</td>
</tr>
<tr>
<td>Metasys Network</td>
<td>Metasys N1 network name where historian node monitor objects are created</td>
</tr>
<tr>
<td>System Name</td>
<td>Metasys N1 system name where Historian node monitor objects are created</td>
</tr>
<tr>
<td>AD Object Name</td>
<td>AD Object name created for Historian node monitoring</td>
</tr>
<tr>
<td>BD Object Name</td>
<td>BD Object name created for Historian node monitoring</td>
</tr>
</tbody>
</table>

6. Click OK. Once the trend collection is configured and running, the trend collector icon appears in the Windows System Tray on the taskbar.
Enabling Trend Collection for Metasy N1 Objects

To enable trend collection for Metasys N1 objects, verify the following:

- If the Trend feature for trend data collection is used, make sure the Trend is defined and started for desired attributes (most likely VALUE) of each object.
- If using the Point History feature, ensure that Point History Archive is enabled for each object.
- Make sure that the USER_APP file destination is defined on the system to which the N1 Trend Collector is connected. The USER_APP file destination must be defined for each desired Access Report Group and Report Type (Trend and/or Point History).
- Verify that the N1 Trend Collector is running, configured, and connected to the system containing MRS. Upon connection, the N1 Trend Collector shows Connected in the status line of the window.

Displaying the N1 Trend Collector Application Window

To display the N1 Trend Collector application window:

1. On the System Tray, right-click the N1 Trend Collector icon.
2. Select Collection Viewer to open the N1 Trend Collector application window (Figure 6-8). The fields are described in Table 6-5.

Defining the USER_APP File Destination

Note: For applications to receive reports, you must define the Personal Computer (PC) file destination called USER_APP. Johnson Controls products are not shipped with this destination predefined. For additional information, refer to the Operator Workstation User’s Manual.

To define the USER_APP file destination:

2. Double-click the Report/Access Group assigned to the system from which you want the N1 Trend Collector to receive reports. The Report Access Group window appears.

Note: If you want to configure hardware objects for data collection, assign USER_APP to Report/Access Group 1.
3. From the Action menu, click Add Destination. The Add Destination dialog box appears.
4. For Destination Type, click PC File. For Destination, select the name of the OWS running the MRS used by the N1 Trend Collector.

5. In the File Name field, type USER_APP.

6. Under Report Type, select the Trend and/or History check box. This instructs the Metasys system to send all data to the MRS.

7. Click OK to accept the new destination file.

8. Click Save from the Item menu to save the new destination file.

9. Perform a Global Upload to save the changes to the archive global database.

After completing these steps, all data from this system is sent to the MRS.

**Defining Analog Data (AD) Points and Binary Data (BD) Points for Historian Node Monitoring**

To define AD and BD points for Historian node monitoring:

1. Edit the supplied DDL to define the AD and BD points.

2. Include the edited DDL into the required NCM DDL file.

**Note:** The supplied DDL (HistStat.ddl) is copied to the target disk when the M5 Workstation is installed and is stored in the M-Data\N1 Trend Collector subdirectory.

**Enabling Offline Node Detection**

To enable offline node detection:

1. From the Windows Start menu, choose Programs > Johnson Controls > N1 Trend Collector. The N1 Trend Collector Application window appears.

2. From the Edit menu, choose Options. The N1 Trend Collector displays the Configuration Options dialog box (Figure 6-13).

3. Check the Enabled check box in the Historian Node Monitoring frame.

4. Click OK. You must ensure that the names of the AD and BD points are identical in all the steps listed above.
Disabling Offline Node Detection

To disable offline node detection:

1. Double-click on the N1 Trend Collector icon in the system tray. The N1 Trend Collector Application window appears (Figure 6-8).

2. From the Edit menu, choose Options. The N1 Trend Collector displays the Configuration Options dialog box (Figure 6-13).

3. Uncheck the Enabled check box in the Historian Node Monitor frame.

4. Click OK.
Troubleshooting

Troubleshooting the Historian Node Monitor

If the Offline Critical Alarm is received from the Watchdog process, one or more of the following error conditions may have occurred. Check for these conditions, in the listed order:

1. The N1 Trend Collector is not currently running. (The N1 Trend Collector icon should appear in the Windows System Tray.)
2. The Historian Node Monitor feature is not enabled within the collector. (Check the N1 Trend Collector Configuration Options dialog box.)
3. The M-Series Workstation/Metasys system to which the N1 Trend Collector is connected is not currently running.
4. The Metasys system is running, but the MRS is not running or has problems communicating with the Metasys system. Check the Metasys errorlog.txt file.
5. The physical Ethernet network between the N1 Trend Collector and the Metasys system has been interrupted. (Check using Windows Explorer.)
6. The Metasys N1 network is not functioning between the MRS and the NCM running the Historian Node Monitoring.

Maintaining the Microsoft Access File Size

The Access Historian is a pre-formatted Microsoft Access database file, and file size is limited to 1 GB. It is not recommended to allow the file size (of TrendDb.mdb) to approach the limit as the associated write times become excessive.

There is no automated mechanism to manage the Access Historian database file. One possible method of maintaining this file is to save a copy of the populated TrendDb.mdb to another directory and/or file name that represents the end date of that file’s data. Then, overwrite the populated TrendDb.mdb with the original master file of the same name.

To switch over to a new trend file:

1. Close any ODBC clients (for example, M-Trend).
2. Shut down the N1 Trend Collector.
3. Copy the active TrendDb.mdb to another directory and/or file name.
4. Copy the master TrendDb.mdb to the location of the previously active file.
Note: The master TrendDb.mdb file is located in the \M-Data\Access Historian\Empty Database directory.

5. Restart the N1 Trend Collector (from the Windows Start menu).

6. Launch any required ODBC clients.

**Trend Sample Bandwidth in Fast Scan Mode**

When the N1 Trend Collector enters Fast Scan mode, the number of samples that can be received and stored is estimated to be approximately 6.5 points per second. (This figure is influenced by the speed of the slowest Ethernet network connection conveying the samples to the N1 Trend Collector, the clock speed of the computer, and the speed of the hard disk storing the samples.)

**Examples**

1. To calculate the number of points that may be processed within a specified time, use the following formula:
   
   \[
   \text{maximum points} = 6.5 \times \text{number of seconds}
   \]

   To calculate the number of points that can be processed in ten minutes, use the formula in this manner:
   
   \[
   \text{maximum points} = 6.5 \times 600
   \]
   
   \[
   \text{maximum points} = 3900
   \]

2. To calculate the time required to process a specified number of points, use the following formula:

   \[
   \text{time required} = \frac{\text{number of points}}{6.5}
   \]

   To calculate the time required to process 5000 points, use the formula in this manner:
   
   \[
   \text{time required} = \frac{5000}{6.5}
   \]
   
   \[
   \text{time required} = 770 \text{ seconds (rounded up)}
   \]
   
   \[
   \text{time required} = 12.9 \text{ minutes (rounded up)}
   \]

**Note:** These formulas are based upon laboratory testing, and are intended to be representative of real-world performance. Actual performance may vary.

**Actual Performance Benchmarks**

Every time the N1 Trend Collector is shut down, performance statistics are stored in the log file. After collecting data for approximately one week, the N1 Trend Collector should supply enough useful information to calculate its actual performance.

**Note:** If you delete the log file while the N1 Trend Collector is working, the N1 Trend Collector log file does not rebuild. You must shut down and restart all N1 Trend Collector sessions in the start-up group. Since the log file is designed to maintain the maximum size, there is no need to delete the log file.
The N1 Trend Collector’s performance statistics are stored in the file N1TrendCollector.log. This file is stored (by default) in the following location:
C:\Documents and Settings\All Users\Application Data\Johnson Controls\M-Data\N1 Trend Collector.

In N1TrendCollector.log there is a parameter called Read and Write Attribute. This parameter contains four values: Minimum, Maximum, Average, and Total Samples. The Read and Write Attribute: Avg figure can be used to calculate the actual performance benchmark. See Figure 6-14.

The Read and Write Attribute: Avg statistic is measured in milliseconds. Use the following formula to obtain the number of samples per second:

benchmark = 1000 / Read and Write Attribute:Avg

This number is the actual performance benchmark (average) measured in samples per second.

To calculate the actual performance benchmark, use the formula in this manner:

benchmark = 1000 / Read and Write Attribute:Avg
benchmark = 1000 / 154
benchmark = 6.5 (rounded up)

Debug Log opened....
Connected to Metasys Remote Server on Local
Disconnected from Metasys Remote Server on Local
OEM Historian Write Time (ms/sample) : N/A
MS-Access Write(ms/sample):Min:0, Max:80, Avg:14, Total:1143
Read Attribute (ms/attr): Min:20, Max:7912, Avg:61, Total:689
Read and Write Attribute (ms/attr): Min:30, Max:7922, Avg:154,
Total Samples:689
Fast Scan Cycle (ms/obj):N/A
Reports (ms/rec): Min:10, Max:100, Avg:21, Total Samples:454
Debug Log closed....

Figure 6-14: N1TrendCollector.log Sample

Performance statistics for the current N1 Trend Collection session can be viewed at any time by choosing View > Statistics from the N1 Trend Collector Application Window Figure 6-8.

Note: Log file is designed as circular file to not exceed 5000 lines in size (when reaches maximum size, N1 Trend Collector deletes lines from the top). If the log file is deleted during N1 Trend Collector running, shut down and restart the N1 Trend Collector to create the new log file.
Fast Scan Configuration
Fast Scan may be configured to scan as many as 5000 points (maximum) every 20 seconds (minimum). Using the calculation in Example 2 above, scanning 5000 points requires approximately 770 seconds (12.92 minutes). In this case, N1 Trend Collector initiates the first scan of 5000 points, wait until it has processed all 5000, (12.9 minutes), wait the specified interval of 20 seconds, and then repeat the process until conditions dictate that Fast Scan mode is disabled.

Accessing Database Files via DSN
When using multiple database files to separate trend reports from point history reports, multiple Data Source Names (DSNs) are required (one DSN for each database file). Refer to Appendix E: Managing DSNs with the ODBC Data Source Administrator (LIT-1153898) for additional information.
Verifying the Operation of the Metasys Remote Server

To verify the operation of the Metasys Remote Server:

Check the Processes tab of the Windows Task Manager for a process called Metahost.

Figure 6-15: Processes Tab of Windows Task Manager

M-Historian Error Codes

Table 6-10 lists all the error codes that can be generated when the N1 Trend Collector is writing to M-Historian database. All the Numeric Value error codes are a negative number. Prior to writing the value to the primary AD point in the Metasys system (DataStat), the error code is changed to a positive number (\( * -1 \)), and then offset by 100 (\( +100 \)).

For example: an error code of -4 is stored as 104 in DataStat. However, the true (negative) error codes are stored in the N1 Trend Collector error log file without being converted.
<table>
<thead>
<tr>
<th>Internal Symbol</th>
<th>Numeric Value</th>
<th>As Positive Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JCI_NO_ERRORS</td>
<td>0</td>
<td>0</td>
<td>Good return value</td>
</tr>
<tr>
<td>JCI_NAME_ALL_BLANK</td>
<td>-1</td>
<td>101</td>
<td>Blank name passed into Create or Write function.</td>
</tr>
<tr>
<td>JCI_ASCII2XTS_FAILED</td>
<td>-2</td>
<td>102</td>
<td>Name exceeds 128 characters maximum.</td>
</tr>
<tr>
<td>JCI_WHIS21DAT_FAILED</td>
<td>-3</td>
<td>103</td>
<td>InfoPlus.21 Database call to write data failed.</td>
</tr>
<tr>
<td>JCI_INISETC_FAILED</td>
<td>-4</td>
<td>104</td>
<td>InfoPlus.21 initialization call failed.</td>
</tr>
<tr>
<td>JCI_NAME_ALREADY_EXISTS</td>
<td>-5</td>
<td>105</td>
<td>Create called with existing name.</td>
</tr>
<tr>
<td>JCI_HISTORIAN_FULL</td>
<td>-6</td>
<td>106</td>
<td>Historian Database Full (no more names)</td>
</tr>
<tr>
<td>JCI_BAD_COPY_NAME</td>
<td>-7</td>
<td>107</td>
<td>InfoPlus.21 API call for CopyRec Name setup failed (in Create Function)</td>
</tr>
<tr>
<td>JCI_COPY_FAILED</td>
<td>-8</td>
<td>108</td>
<td>InfoPlus.21 API calls for CopyRec failed (in Create function).</td>
</tr>
<tr>
<td>JCI_NAME_NOT_EXIST</td>
<td>-9</td>
<td>109</td>
<td>Modify routine failed to find name.</td>
</tr>
<tr>
<td>JCI_ENG_UNITS_FAILED</td>
<td>-10</td>
<td>110</td>
<td>Modification of engineering units failed.</td>
</tr>
<tr>
<td>JCI_TIMEZONE_FAILED</td>
<td>-11</td>
<td>111</td>
<td>Modification of time zone failed.</td>
</tr>
<tr>
<td>JCI_HISTORIAN_UNAVAIL</td>
<td>-12</td>
<td>112</td>
<td>Historian connection is not available.</td>
</tr>
<tr>
<td>JCI_HIST_NO_CONNECT</td>
<td>-13</td>
<td>113</td>
<td>InfoPlus.21 API calls fore INITSETC fails, historian probably not running.</td>
</tr>
<tr>
<td>JCI_ALREADY_DISCONNECTED</td>
<td>-14</td>
<td>114</td>
<td>Historian already disconnected, as per request.</td>
</tr>
<tr>
<td>JCI_ALREADY_CONNECTED</td>
<td>-15</td>
<td>115</td>
<td>Historian already connected, as per request.</td>
</tr>
<tr>
<td>JCI_LONGNAME_FAILED</td>
<td>-16</td>
<td>116</td>
<td>Insert of LONG_NAME failed in Create function.</td>
</tr>
<tr>
<td>JCI_BAD_TYPE</td>
<td>-17</td>
<td>117</td>
<td>Bad data type passed in variant structure.</td>
</tr>
<tr>
<td>JCI_BAD_ARRAY_TYPE</td>
<td>-18</td>
<td>118</td>
<td>Bad data type passed in OLE array.</td>
</tr>
<tr>
<td>JCI_BAD_ARRAY_CONTENTS</td>
<td>-19</td>
<td>119</td>
<td>Invalid OLE array, or bad data in array.</td>
</tr>
<tr>
<td>JCI_ARRAY_ACCESS_ERROR</td>
<td>-20</td>
<td>120</td>
<td>Unable to access an OLE array.</td>
</tr>
<tr>
<td>JCI_CHG_WORDSIZE_FAILED</td>
<td>-21</td>
<td>121</td>
<td>InfoPlus.21 API calls for CHGDBWDS failed during increase for new point.</td>
</tr>
<tr>
<td>JCI_SYSPROC_GET_ERROR</td>
<td>-22</td>
<td>122</td>
<td>Unable to get system processes to check for tasks running.</td>
</tr>
<tr>
<td>JCI_HISTTASK_NOT_ACTIVE</td>
<td>-23</td>
<td>123</td>
<td>One of the tasks for historian is not running.</td>
</tr>
<tr>
<td>JCI_ERROR_FATAL</td>
<td>-24</td>
<td>124</td>
<td>Fatal error (undetermined)</td>
</tr>
<tr>
<td>JCI_ERROR_INVALID_DSN</td>
<td>-25</td>
<td>125</td>
<td>Invalid DSN or Variant type for DSN</td>
</tr>
<tr>
<td>JCI_ERROR_ADO</td>
<td>-26</td>
<td>126</td>
<td>Error occurred in ADO interface. IErrorInfo provides more details.</td>
</tr>
<tr>
<td>JCI_ERROR_UNAVAIL_ADO</td>
<td>-27</td>
<td>127</td>
<td>Unable to determine ADO error(s).</td>
</tr>
<tr>
<td>JCI_ERROR_NAME_GENERATE</td>
<td>-28</td>
<td>128</td>
<td>Unable to generate a new name (number).</td>
</tr>
<tr>
<td>JCI_ERROR_INVALID_TABLE</td>
<td>-29</td>
<td>129</td>
<td>Invalid table type specified.</td>
</tr>
<tr>
<td>JCI_ERROR_EMPTY_RECSET</td>
<td>-30</td>
<td>130</td>
<td>No data available – empty record set.</td>
</tr>
<tr>
<td>JCI_ERROR_INVALID_DATE</td>
<td>-31</td>
<td>131</td>
<td>Timestamp is not valid.</td>
</tr>
<tr>
<td>JCI_ERROR_ADO DUPREC</td>
<td>-32</td>
<td>132</td>
<td>Duplicate record found during Insert.</td>
</tr>
<tr>
<td>JCI_ERROR_INSERTSUP</td>
<td>-33</td>
<td>133</td>
<td>Insert mode is not supported.</td>
</tr>
<tr>
<td>JCI_ERROR_ARRAY_DIM</td>
<td>-34</td>
<td>134</td>
<td>OLE array dimensions are invalid.</td>
</tr>
<tr>
<td>JCI_ERROR_ARRAY_ELEMENT</td>
<td>-35</td>
<td>135</td>
<td>OLE array elements are not the same.</td>
</tr>
<tr>
<td>JCI_ERROR_ELEMENT_WRITE</td>
<td>-36</td>
<td>136</td>
<td>One or more OLE array elements Write failed.</td>
</tr>
<tr>
<td>JCI_ERROR_UNAVAIL_OEM</td>
<td>-37</td>
<td>137</td>
<td>One or more OLE arrays Write failed.</td>
</tr>
<tr>
<td>JCI_Error_OEM</td>
<td>-38</td>
<td>138</td>
<td>Error occurred in OEM Historian database. IErrorInfo provides more detail.</td>
</tr>
<tr>
<td>JCI_ERROR_TAGNAME_SUP</td>
<td>-39</td>
<td>139</td>
<td>OEM Historian database does not support tag name change.</td>
</tr>
<tr>
<td>JCI_ERROR_REGKEY_OPEN</td>
<td>-40</td>
<td>140</td>
<td>Registry key Open failed.</td>
</tr>
</tbody>
</table>
Special Error Codes

The error codes in Table 6-12 are typically caused by communications trouble between the N1 Trend Collector and a database interface.

Table 6-12: Special Error Codes

<table>
<thead>
<tr>
<th>Internal Symbol</th>
<th>Numeric Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERR_COLE_EXCEPTION</td>
<td>1000</td>
</tr>
<tr>
<td>ERR_COMM_ERROR_EXCEPTION</td>
<td>1001</td>
</tr>
<tr>
<td>ERR_UNKNOWN_EXCEPTION</td>
<td>1002</td>
</tr>
<tr>
<td>ERR_C_EXCEPTION</td>
<td>1003</td>
</tr>
<tr>
<td>ERR_OEM_HISTORIAN_NOT_RUNNING</td>
<td>1004</td>
</tr>
<tr>
<td>ERR_CANNOT_CONNECT_TO_DATA_SOURCE</td>
<td>1005</td>
</tr>
<tr>
<td>ERR_INVALID_REPORT_TYPE</td>
<td>1006</td>
</tr>
<tr>
<td>ERR_INVALID_SAMPLE_TYPE</td>
<td>1007</td>
</tr>
<tr>
<td>ERR_NOT_CONNECTED_TO_DBMS</td>
<td>1008</td>
</tr>
<tr>
<td>ERR_DBMS_NOT_SELECTED</td>
<td>1009</td>
</tr>
<tr>
<td>ERR_NO_SAMPLES_AVAILABLE</td>
<td>1010</td>
</tr>
<tr>
<td>ERR_TIMEZONE_NOT_AVAILABLE</td>
<td>1011</td>
</tr>
</tbody>
</table>

Note: A numeric return value of -1 usually means the database is not selected for storage.

Data Collection Troubleshooting

To Determine if Data Is Being Stored

1. Double-click the N1 Trend Collector icon in the Windows system tray.
2. Examine the value in the Status column.
3. If the value in the Status column is zero, the database write is successful.
4. Any value other than zero indicates an error. See Table 6-11 and Table 6-12 for a complete listing of M-Historian error codes.

To Determine if the OWS Is Receiving Data from the N1 Network

1. Add a computer file as the destination for Trend and/or Point History.
2. Check the contents of the file for data. If no data is being stored to the file, the N1 Trend Collector is not receiving data.

To Determine if N1 Trend Collector Is Receiving Data from the Metasys System

Examine the N1 Trend Collector application window. All received data appears in this window, up to the configured limits.
To Determine if N1 Trend Collector Is Experiencing Errors

Check N1TrendCollector.log for errors. N1TrendCollector.log is stored in the M-Data\N1 Trend Collector directory. Examine the message dates carefully, as this file is created by appending new entries to the existing entries, and some messages may be very old.

Multiple Trend Collection Errors

To start automatically when a user logs on, the trend collection definition files are stored in the Windows Startup group. Occasionally, multiple trend collections may be defined. Operations may become erratic if multiple trend collections start automatically and write to a single Microsoft Access database. If this occurs, multiple N1 Trend Collector icons appear in the Windows system tray.

To prevent trend collections from starting automatically, remove the unnecessary trend collections from the Windows Startup group.

Trend Collection Does Not Start Automatically

If trend collection does not begin automatically when the system initializes, check TrendCollector.log for error messages. If the associated ODBC DSN is not available, trend collection cannot begin, and the Trend Collector icon does not appear in the Windows system tray.

Local Trend Collection Connection Errors

The connection status of a trend collection may be verified by looking in the status bar of the N1 Trend Collector application window. The status bar contains either Connected or Not Connected.

TCP/IP is used for trend collection communications in both the All in One and Remote System installations. Check the operation of TCP/IP to resolve trend collection connection errors. Refer to Enabling Trend Collection for Metasys N1 Objects in this chapter for additional information.

Changing the Location of the Microsoft Access Database

To change the location of the Microsoft Access database after installation of the M5 Workstation, the ODBC System DSN must be modified to map to the database’s new location. See Appendix E: Managing DSNs with the ODBC Data Source Administrator (LIT-1153898) in this guide for more information.
**Microsoft Access Database Fills Too Quickly**

If excessive data fills the Microsoft Access database too quickly, store the Point History and Trend data in two separate databases. To separate the databases, you must configure:

- two separate database files
- two unique DSNs
- two trend collectors (one with Point History enabled, one with Trend enabled)

**TrendDB.mdb Has Become Corrupt**

If the installed copy of TrendDB.mdb is unusable, overwrite the installed copy with a blank copy found in the M5 M-Data\Access Historian\Empty Database directory or on the Workstation CD-ROM.

**Troubleshooting the Windows Registry Entries**

Any wrong alteration to Windows registry entries can cause serious damage to the system. Take extra caution when altering registry values.

Locate all registry entries used specifically by N1 Trend Collector are at:

HKEY_LOCAL_MACHINE\SOFTWARE\Johnson Controls\N1 Trend Collector

**Startup Delay Using InfoPlus.21 Historian: InfoPlus.21 Historian Timeout**

When Windows operating system first starts up on a machine, all related Operating System (OS) services must start before the client applications are able to run. The InfoPlus.21 services operate the same way. The InfoPlus.21 services must start before the N1 Trend Collector can begin to store data into the database. On some machines, the InfoPlus.21 services cannot start up in the predefined amount of time. In this case, the N1 Trend Collector assumes that the machine is permanently offline until N1 Trend Collector restarts.

The wait period is a configurable startup delay, in seconds, for InfoPlus.21 Historian. The default wait time is 180 seconds. Modify the InfoPlus21 Timeout registry entry to change the default value.

**Note:** Do not use the value of ffffffff (in hexadecimal) to set the internal default value as in the other registry entries discussed below.
**Performance Related**

The N1 Trend Collector performs well under normal circumstances. It processes and stores data very quickly. However, the collector may take a few minutes to process extreme volumes of incoming trend and point history data, especially data that occurs on the half-hour intervals when point history collection is enabled.

If the collector is processing incoming reports for more than 60 seconds, it is possible for the collector to falsely detect that the Metasys Remote Server is offline. It is also possible for the read attribute requests to time out during fast scan processing.

**Note:** The offline detection is actually done in a shared component that the collector uses for communicating to the MRS. The component is called MHClient.

This offline problem can be seen by examining the N1TrendCollector.log file. The entries for the offline detection appear as follows:

```
2001/10/30 14:01:53 // // Disconnected from Metasys Remote Server on Local
2001/10/30 14:02:13 // // Connected to Metasys Remote Server on Local
```

If these entries continuously appear in the log file, check if the node where the Metasys Remote Server resides is actually shutting down and restarting due to operator intervention. Perhaps a user is restarting Metasys system on that node. If this problem is not caused by user intervention, you may use the **MRS_WatchdogPeriod** registry entry to increase the watchdog period used for detecting the disconnects.

By default, this value is **ffffffff** (in hexadecimal). This value indicates that the default from MHClient should be used. The default is 60,000 milliseconds or 60 seconds.

To modify the default value:

1. Double-click on the **MRS_WatchdogPeriod** in the registry.
2. Click on the Decimal radio button.
3. Type in a value greater than 60000.

**Note:** Try 90000 or 120000 (90 or 120 seconds).

4. The problem for the read attribute timeout appears:

```
```
This happens if a read attribute request takes longer than 5 seconds. For large data requests, increase the timeout that closely matches the value of MRS_WatchdogPeriod. The registry entry for this timeout value is called MRS_MetasysMsgTimeOut. This value is located in the same part of the registry as the watchdog period entry. The default is obtained from MHClient and has a value of 5000 milliseconds (5 seconds). If the above error log entry is seen multiple times, try increasing the value of this timeout to some value close to the value entered for MRS_WatchdogPeriod (for example, 85000 or 115000 in decimal).

Another registry entry related to MRS_MetasysMsgTimeOut is called FastScanTimeout. The value of this should match the value of MRS_WatchdogPeriod. The default value of this entry is 60000 milliseconds (60 seconds).

### Table 6-13: N1 Trend Collector Registry Entries for Timing Adjustments

<table>
<thead>
<tr>
<th>Name</th>
<th>Default Value</th>
<th>Default Interpretation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MRS_WatchdogPeriod</td>
<td>ffffffff</td>
<td>60,000 mSecs</td>
<td>Timeout value between MHClient and MRS.</td>
</tr>
<tr>
<td>MRS_MetasysMsgTimeout</td>
<td>ffffffff</td>
<td>5,000 mSecs</td>
<td>Timeout value between MHClient and Metasys system for read attribute calls</td>
</tr>
<tr>
<td>FastScanTimeout</td>
<td>60000</td>
<td>60,000</td>
<td>Timeouts in N1 Trend Collector in regards to each read attribute request to MHClient</td>
</tr>
</tbody>
</table>

**Note:** Any one of these registry entries can be set to ffffffff (in hexadecimal). When this value is entered, the N1 Trend Collector uses the default value for the attribute.
Key Concepts

M-Trend Features

The M-Trend component allows you to:
• create, edit, save, and display M-Trend document files
• compare archived trend data from different times
• verify the proper operation of controlled temperatures or devices
• track usage of billable items
• perform diagnostics on your Facility Management System (FMS)

M-Trend Data Connection Overview

M-Trend is used for viewing trend data stored in M-Historian (either an AspenTech InfoPlus.21 or Microsoft Access) database. The databases can be located on the same machine as the viewer, or on another machine on an Ethernet network.

Related Information

Using M-Trend in the M5 Workstation requires setting up several pieces of software to work together. For information on the software and tasks involved, see the documents listed in Table 7-1.

Table 7-1: M-Trend Related Information

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up a Database Connection for M-Trend –</td>
<td>Connecting M-Trend to a Database (LIT-6450040) chapter in the M-Trend</td>
</tr>
<tr>
<td>Includes the Steps for Establishing a Data Connection</td>
<td>User’s Manual</td>
</tr>
<tr>
<td>through the ODBC Administrator</td>
<td></td>
</tr>
<tr>
<td>Collecting Trend Data</td>
<td>N1 Trend Collector (LIT-1153870)chapter in this manual</td>
</tr>
<tr>
<td>Storing Trend Data</td>
<td>M-Historian Overview Technical Bulletin (LIT-646100)</td>
</tr>
<tr>
<td>Defining M-Trend Documents</td>
<td>Defining M-Trend Documents (LIT-6450050) chapter in the M-Trend User’s</td>
</tr>
<tr>
<td></td>
<td>Manual</td>
</tr>
<tr>
<td>Viewing M-Trend Documents</td>
<td>Getting Started (LIT-6450030) and Defining M-Trend Documents (LIT-6450030) chapters in the M-Trend User’s Manual</td>
</tr>
</tbody>
</table>
Appendix A

M-Bind.mdb

The component binding information is stored in a Microsoft Access database named M-Bind.mdb. The database contains the information in Table A-1. The Binding Name is the primary key and the Document Type is the secondary key. Figure A-1 is an example of this database.

**IMPORTANT:** Editing this table is not recommended.

**Table A-1: M-Bind.mdb File Description**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Maximum Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metasys Name</td>
<td>The name of the client application specific link. Can be any qualified network, group, or system.</td>
<td>255</td>
</tr>
<tr>
<td>Document Type</td>
<td>The file extension identifying the component</td>
<td>8</td>
</tr>
<tr>
<td>Document Name</td>
<td>Entire directory path of the component file</td>
<td>255</td>
</tr>
<tr>
<td>Alias Name</td>
<td>Name of an alias used in one of the component files</td>
<td>32</td>
</tr>
<tr>
<td>Alias Value</td>
<td>The value substituted for the alias in the component files</td>
<td>32</td>
</tr>
</tbody>
</table>

The following figure is an example of this database.

**Figure A-1: Example of M-Bind.mdb File**
Appendix B

ProjInfo.ini

Introduction

Functions of Screen Manager operations are stored in the ProjInfo.ini file. Every time Screen Manager loads, the contents of ProjInfo.ini are read, and Screen Manager behaves according to the values stored in the file. These functions include the following:

- data file locations
- filters
- history
- M-Graphics application override information
- M-Alarm application override information
- Applications list parameters
- Command bar parameters

Note: Do not modify ProjInfo.ini manually. Use the Screen Manager Properties and Application Properties dialog boxes to modify these settings.
Key Concepts

ProjInfo.ini

The Screen Manager data directory contains the configuration file ProjInfo.ini. The settings stored in this file are managed automatically by the Screen Manager Properties and Application Properties dialog boxes. Figure B-1 is an example of ProjInfo.ini.

<table>
<thead>
<tr>
<th>[Default Data Files]</th>
</tr>
</thead>
<tbody>
<tr>
<td>; This section identifies directories that contain data files in addition to the current project dir.</td>
</tr>
<tr>
<td>; Include1 thru Include100 can be used to specify up to 100 additional directories.</td>
</tr>
<tr>
<td>Include1=C:\FMS\DATA</td>
</tr>
<tr>
<td>Include2=C:\Program Files\Johnson Controls\M-Data\</td>
</tr>
<tr>
<td>include100=</td>
</tr>
<tr>
<td>;</td>
</tr>
<tr>
<td>; Filters identify those files extensions (separated by commas) that should not appear in the project.</td>
</tr>
<tr>
<td>IgnoreExtFilters=.zip,.dll,.rip,.tdf</td>
</tr>
<tr>
<td>;</td>
</tr>
<tr>
<td>; Identifies whether or not to display unknown application documents in the Application Browser.</td>
</tr>
<tr>
<td>IgnoreUnknownApps=yes</td>
</tr>
<tr>
<td>; This section records the last used layouts.</td>
</tr>
<tr>
<td>[History]</td>
</tr>
<tr>
<td>Layout1=1mon1pnl1reg</td>
</tr>
<tr>
<td>Layout2=Layout1</td>
</tr>
<tr>
<td>Layout3=temp2</td>
</tr>
<tr>
<td>Layout4=temp1</td>
</tr>
<tr>
<td>Layout5=1mon2pnlvn1reg</td>
</tr>
<tr>
<td>Layout6=</td>
</tr>
<tr>
<td>Layout7=</td>
</tr>
<tr>
<td>Layout8=</td>
</tr>
<tr>
<td>Layout9=</td>
</tr>
<tr>
<td>Layout10=</td>
</tr>
</tbody>
</table>

Continued on next page . . .

Figure B-1: Example ProjInfo.ini File
; Application Override information appears here.

[gwx32]
Alias=M-Graphics
CommandLine=-runtime

[Awx32]
Alias=M-Alarm

[Application List]
; This flag determines whether subdirectories of the directories
; defined in the [Default Data Files] section are included in the
; screen Manager application list
IncludeSubdirectories=yes

[Command Bar]
; Screen Manager Properties
LockPosition=no
AutoHide=no
AlwaysonTop=no
ToolTip=yes
ButtonLabels=yes
DefaultLayout=1mon1pnl.pwf
SlideShow=no

---

Figure B-1 (cont.): Example ProjInfo.ini File

Note: Do not modify ProjInfo.ini manually. Use the Screen Manager Properties and Application Properties dialog boxes to modify these settings.

Default Data Files

Default Data Files variables (Include1 to Include100) specify a data directory and up to 100 directories which contain application data files. These files can be assigned to panels in Screen Manager. The Application Browser displays files located in the specified directories.

Ignore External Filters

Within the Default Data Files section the IgnoreExtFilters variable excludes specific file extensions from the current project. File types that Screen Manager cannot associate with an application display with a yellow question mark in the Application list. The Application Browser does not display file types listed in IgnoreExtFilters. Extensions are separated by a comma; see Figure B-1.

To prevent this feature from displaying unassociated files, add the file extension to the IgnoreExtFilters variable. Add these file extensions to the IgnoreExtFilters using the Screen Manager Properties dialog box.
History

The History section contains ten variables (Layout1 to Layout10) that record the last ten layouts viewed. This feature allows instant switching between any of the last ten layouts. Clicking the Recent button displays the identical list of layouts.

Gwx32

The gwx32 section contains application override information. All variables in this section are managed by the Applications Properties dialog box.

Awx32

The awx32 section contains application override information. All variables in this section are managed by the Applications Properties dialog box.

Application List

The Application List section of ProjInfo.ini contains the variables described in Table B-1, used to control the function of the Application list (displayed on the Screen Manager command bar):

Table B-1: Application List Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Available Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncludeSubdirectories</td>
<td>Yes</td>
<td>The Application list browses subdirectories of every entry in the Default Data Files.</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>The Application list is restricted to browsing in the listed directories only.</td>
</tr>
<tr>
<td>IgnoreUnknownApps</td>
<td>No</td>
<td>The Application list does not filter. All files defined in Default Data Files variables display.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>The Application list filters out all files that do not have an application associated with them.</td>
</tr>
</tbody>
</table>
Command Bar

The Command Bar section of ProjInfo.ini contains the following variables that control operation of the Screen Manager command bar:

Table B-2: Command Bar Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Values</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>LockPosition</td>
<td>Yes or No</td>
<td>When set to Yes, LockPosition locks the command bar to the edge of the screen to which it is currently docked. When the value is set to No, LockPosition allows the user to drag the command bar to the center or any edge of the primary display.</td>
</tr>
<tr>
<td>AutoHide</td>
<td>Yes or No</td>
<td>When set to Yes, AutoHide automatically hides the command bar when it is docked to any edge of the primary display.</td>
</tr>
<tr>
<td>AlwaysOnTop</td>
<td>Yes or No</td>
<td>When set to Yes, AlwaysOnTop forces the command bar to have the highest view order (to always be on top). When set to No, AlwaysOnTop allows the user to cover the command bar with other items.</td>
</tr>
<tr>
<td>Tool Tips</td>
<td>Yes or No</td>
<td>When set to Yes, Tool Tips (the ProjInfo.ini parameter) allows the command bar to display a tool tip (a short descriptive label) when the cursor is held over a command bar button.</td>
</tr>
<tr>
<td>Button Labels</td>
<td>Yes or No</td>
<td>When set to Yes, Command bar displays a label under each Command bar button.</td>
</tr>
<tr>
<td>Default Layout</td>
<td>Path and Filename</td>
<td>Path and filename of the layout to be used when the command bar is running, but no user is logged in. (This variable is optional, and may remain unspecified.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: If Use Slide Show is selected, Default View is not available. See Table 5-5 in the Using Screen Manager chapter of this guide.</td>
</tr>
<tr>
<td>SlideShow</td>
<td>Yes or No</td>
<td>When set to Yes, the Command bar does not display the default view when the Command bar is running and no user is logged in. Instead, the Command bar reads the file SlideShow.txt and displays a slide show, based on the instructions contained in the file. The file, SlideShow.txt, is stored in Screen Manager’s home directory. (This variable is optional, and may remain unspecified.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: If Use Slide Show is selected, Default View is not available. See Table 5-5 in the Using Screen Manager chapter of this guide.</td>
</tr>
</tbody>
</table>
Appendix C

Metasys OWS AutoLogin

Introduction

Metasys AutoLogin is an M5 Workstation function that applies the M-Password password to Metasys. Users need one password to log in to both M-Password and the Metasys system at the same time.

When this feature is correctly configured, clicking the Metasys button on the Screen Manager command bar displays the Network Map instead of the Metasys login panel.
Key Concepts

Metasys OWS AutoLogin

During installation the user is prompted to enter a default network for AutoLogin purposes. If the user supplies a network as the default and the password is identical to the Screen Manager password, AutoLogin automatically logs into the default network with the Screen Manager password. In this case, clicking the Metasys button on Screen Manager displays the Network Map for the default network.

If the user does not supply a default network for AutoLogin purposes during the installation procedure, AutoLogin is not configured. In this case, AutoLogin can be configured manually. See Manual Setup in this Appendix for more information.

Auto Logon to M-Password from Windows NT

Note: This feature is supported on both Windows NT and Windows 2000 platforms.

M-Password supports auto logon to M-Password from Windows NT Logon. To utilize this feature, the Windows NT Workstation must be a member of a Windows NT Domain. Verify that the M-Password username is synchronized with the username in Windows NT Security Account Managers (SAM) database. The administrators are responsible for making sure the usernames in both M-Password and Windows NT SAM are the same. It is not necessary for the passwords to match. For more information refer to the M-Password Technical Bulletin (LIT-1153150).
Detailed Procedures

Manual Setup

To manually set up OWS AutoLogin:

1. Change the Metasys password to be identical to the M-Password password.

2. Using Windows NotePad or WordPad, open the Metasys.ini file in the Windows\System directory.

3. Beneath the header labeled [Metasys], enter the following line of code:
   \n   AutoLogin=1

4. Beneath the header labeled [Metasys], enter the following line of code:
   \n   DefaultNetwork= <enter the name of the default network here>

5. Restart M5 Workstation.

6. Click the Metasys button on the Screen Manager command bar. Screen Manager displays the Network Map.

Changing Passwords

If Metasys AutoLogin is configured and it is necessary to change the Screen Manager password, the Metasys password also must be changed to the new Screen Manager password for AutoLogin to remain functional. If the two passwords do not remain synchronized, clicking the Metasys button on Screen Manager displays the Metasys Login dialog box and not the Network Map.
**Troubleshooting**

Verify the following conditions for AutoLogin to work correctly:

- Metasys password must be identical to the M-Password password.
- AutoLogin must be set in the Metasys.ini file.
- Default network name must be specified in Metasys.ini file.
Appendix D

Screen Manager Slide Show

Introduction

The Slide Show feature allows Screen Manager to display a repeating series of layouts when no user is logged into M-Password. If a Slide Show is defined in the Screen Manager Properties display, the Default Layout is disabled. If neither Default Layout or Slide Show is defined, Screen Manager loads without an initial layout.

Note: This feature is not supported on the Windows 98 platform.

IMPORTANT: The Metasys PMI slide show does not work if M5 Workstation is loaded. Use the M5 Workstation slide show instead.
**Key Concepts**

**SlideShow.txt**

SlideShow.txt is a text file (stored in the Screen Manager directory) used to specify the playlist for the Slide Show. The Layout files (*.pwf) are stored in the current project directory. In the example shown in Figure D-1, the Slide Show displays Layout1.pwf for 10 seconds, Layout2.pwf for 10 seconds, Layout4.pwf for 30 seconds, and then repeats the sequence, starting with the first entry.

Note: A demonstration version of SlideShow.txt is shipped with the M5 Workstation software. This version may be used as shipped, or may be modified to suit requirements.

<table>
<thead>
<tr>
<th>10</th>
<th>Layout1 ;loads Layout1.pwf for 10 seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Layout2 ;loads Layout2.pwf for 10 seconds</td>
</tr>
<tr>
<td>30</td>
<td>Layout4 ;loads Layout4.pwf for 30 seconds</td>
</tr>
</tbody>
</table>

**Figure D-1: SlideShow.txt**

**Default Location**

**New Installations**

By default, SlideShow.txt is located in the following directory:

C:\Documents and Settings\All Users\Application Data\Johnson Controls\M-Data\Screen Manager

**Upgraded Installations**

For systems that have upgraded the M5 Workstation software from Release 1.0 or 1.1, the original directory location is maintained:

C:\FMSDATA\M-ScrMgr
Slide Show Specifications

Due to the processing required to update images with static and dynamic data, minimum times should be used with all Slide Show images. See Table D-1 for recommended minimum durations. Trial and error will determine the minimum durations required for each image type. Factors to be considered when configuring a slide show include:

- processor clock speed
- location of graphics files (local or network)
- number of dynamic/static data variables
- network baud rate and traffic conditions

When testing a slide show, ensure that all images are successfully updated with all static and dynamic data before loading the next image. Durations must be increased for images that fail to update all their static and dynamic data consistently.

Table D-1: Slide Show Specifications

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Minimum Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>5 seconds</td>
</tr>
<tr>
<td>Dynamic</td>
<td>30 seconds</td>
</tr>
</tbody>
</table>
Appendix E

Managing DSNs with the ODBC Data Source Administrator

Introduction

Data Source Names (DSNs) are used by the Microsoft Open Database Connectivity (ODBC) utility to manage the mapping of database clients and servers. ODBC settings are managed via the ODBC Data Source Administrator, available from the Windows Control Panel.
Detailed Procedures

Mapping the Location of the M-Historian Database using the ODBC Control Panel

To map the location of the M-Historian database using the ODBC Control Panel:

1. From the Windows Start Menu, choose Settings > Control Panel.
2. Double click on Data Sources (ODBC). Windows displays the ODBC Data Source Administrator dialog box (Figure E-1).

![ODBC Data Source Administrator Dialog Box](image)

3. Select the System DSN tab (Figure E-2).
4. Select the required Data Source (Access Historian, if AspenTech database is not installed). The DSN is now mapped to the correct database and the M5 Workstation components are now mapped to the correct database.

5. Click the Configure button. Windows displays the ODBC Microsoft Access Setup dialog box (Figure E-3).
6. Click the Select button in the Database frame. The Select Database dialog box appears (Figure E-4).

7. Select the required database and click OK. The ODBC Microsoft Access Setup dialog box appears (Figure E-3).

8. Click OK. The ODBC Data Source Administrator dialog box appears (Figure E-1).

9. Click OK.
The DSN is now mapped to the correct M-Historian file (using the ODBC Data Source Administrator).
Appendix F

Configuring the Historian Node Monitor

The AD (Analog Data) and BD (Binary Data) points used to monitor the required Historian node are contained in a file named HistStat.ddl, which, by default, is located in the following directory:

C:\Documents and Settings\All Users\Application Data\Johnson Controls\M-Data\N1 Trend Collector

The JC BASIC process used to monitor the required Historian node is named DataHist.bas and, by default, is located in the following directory:

C:\Documents and Settings\All Users\Application Data\Johnson Controls\M-Data\N1 Trend Collector

System and Object Names

DataHist is the default name of the system where the three required data points are defined. This system name must match exactly the system name used in the JC BASIC process.

The object names are DataStat, HistErr, and HistStat. These three object names are inter-related, and must also match exactly the object names used in the JC BASIC process.

There are only two reasons why system or object names would require renaming:

• if there is a conflict with another system or object name on the same Metasys network

• if there is more than one Historian Node to monitor. In this case, a separate set of object names must be defined for each node that is to be monitored.

In order to successfully configure the Historian Node Monitoring process, the following two procedures (Defining the AD and BD Points and Configuring the JC BASIC Process) must be completed in order.
Defining the AD and BD Points

Note: To complete the steps in this section, you must be familiar with the Metasys DDL (Data Definition Language) feature. See the Operator Workstation Manual, for more information.

To define the AD and BD points:

1. Add the contents of the supplied Data Definition Language (DDL) file (HistStat.ddl) to the appropriate NC’s DDL file.

Note: For most applications, the system and object names require no modification.

2. Add the system name to the required PC Group in the global DDL file.

3. Compile the DDL files and ensure no errors exist.

4. Download the modified global DDL file via the Network Map.

5. Download the modified DDL file to the appropriate NC via the Network Map.

Configuring the JC Basic Process

Note: In order to complete the steps in this section, you must be familiar with the JC BASIC Compiler and the steps required to edit, compile, and download processes. See the Operator Workstation Manual, for more information.

To configure the JC BASIC process:

1. Make a copy of the supplied JC BASIC process as a backup.

2. Edit the file as detailed in the next three steps.

3. The NC Name within the file must be changed from NCNAME to the name of the NC where the process will run.

4. The system name must match exactly the system name used in the global DDL file. If the system name in the global DDL file has been modified, it must also be modified in this file to match. (If the system name in the global DDL file has not been modified, no modification of system name is required in the JC BASIC process.)
5. The object names must match exactly the object names used in the
NC DDL file. If the object names in the NC DDL file have been
modified, they also must be modified in this file to match. (If the
object names in the NC DDL file have not been modified, no
modification of the object names is required in the JC BASIC
process.)

6. Copy the modified JC BASIC process to the appropriate system
directory, located in the FMSDATA directory.

7. Compile the JC BASIC process and ensure no errors exist.

8. Download the JC BASIC process to the NC via the Network Map.

Configuring the N1 Trend Collector

Refer to *N1 Trend Collector (LIT-1153870)* chapter in this guide for
information on configuring the N1 Trend Collector for Historian Node
Monitor applications.